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android 93 3CRY

H4 B Android?
Android &N [ TR B E) EEA HUB PRI, ' e MR R 4L A —

i 7 B YRR . Beta i ) Android SDK #2417 7£ Android “F- & _F{# ] JaVa
W5 4T Android B JF R AR T EA API 21D .

etk

o NMARFEZR CRHAMMERS S5

o Dalvik BN LRI HMAL

o FERMINYEEE TN WebKit 5%

. MAKBREE wiEeHr 2D K’ E, 3D EIEEFEHT OpenGL ES 1.0
CREA o AT 3k )

o SQLite FAMESEMIMHIEIE 1%

o ZWMATFF WIE WS A E S EIG A (0 MPEG4, H.264,
MP3, AAC, AMR, JPG, PNG, GIF)

o GSM HIERAR (HRHTHEIF)

« I ZF Bluetooth, EDGE, 3G, 1 WiFi (K#i T}

. [BHHNL, GPS, ¥EF4T, FIMEEIT (accelerometer)  (HKH AR

o FEMFRFE GFERAEDE, WX THR, WAFELERSITEER, M
Eclipse £ T K I B diF

Android ZE#
TEE/RFE Android B:4E R F A M. B0 27E T B A .
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http://code.google.com/android/download.html
http://webkit.org/
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APPLICATIONS

Contacts Phone Browser

APPLICATION FRAMEWORK ‘

Window Content
Activity Manager Manager Providers

Package Manager

|
\
Telephony Resource Location Notification ‘

Manager Manager Manager Manager ‘

LIBRARIES ANDROID RUNTIME

Surface Manager Media SQLite Core Libraries
Framework

OpenGL | ES FreeType WebKit Bavievirtt

Machine

SGL SSL libe A‘

LINUX KERNEL

Displa Flash Memo Binder (IPC)
Dnlilez Camera Driver Driver 2 Driver

Audio Power
Keypad Driver WiFi Driver Drivers Management

RL R

Android 2 [A]— Z F %0 B HTRE 7 B — i AT, 1% 8 R A B4 email 257 i,
SMS JEH BAE, B, i, wbass, KARNEEEFE. Jraf Ny
#HAMEH JAVA EE RS 1.

L 72 P HE SR

FER N G AT DL SE AU [l RO B AL 7 BT A 1) AP REZE o 38 I AE 7 B 484
BT R AL T AR B EE R 5 AR AT — AN B FH AR P A T LR AR & 1 Th e Bt BAR (T e
(1% S FH & 3 # mT ASE FH FE B AT i D g O I A R HE 22 1) 22 A MR R 1D o [
FE, 2N R 2R AL A A P mT DA {8 ) 38 R iy 24
S e A B S5 T A2 — R IR S A R 4, o,
o EEIMNAYRAAE (Views) , "L RMERN T, ©aiEsl
* (lists) , W% (grids) , CAHE (text boxes) , #4l (buttons) ,
H 2 TR A web 3%
o HZIRALES (Content Providers) #1453 HFE /7 Al LAVG ] 55— AN AR
PEE (B R ANEE ), BE L= elE s
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http://www.chinaup.org/docs/reference/view-gallery.html
http://www.chinaup.org/docs/devel/data/contentproviders.html
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o WIHEHEZE (Resource Manager) $efit JEARAGBUR AT ), WA M ZFF
L, B, A RscH C layout files ) o
o TS  (Notification Manager) {758 FFER 7] AZEAR AL i
7~ E LHRRE R
o THENEHLY ( Activity Manager) SR BN FE P AR i B R SR AR
FH A ER T RE
AREZMM T MEFENKE —AMNHERF, 5% {145 —1> Android
HEER.

T2 PR
Android 7% C/C++/E, XEEFEREH; Android RS ARIFAEAEH . e
it Android N HFEFHEZE NIT K& S BEIRSS . PLF 2 — ez e

« R% C FE - —/ BSD ZkACkKIbRHE C RGEEE ( libc ), E
LT ANRT embedded linux 1345 5E Hill 1 .

o YKFE - FT PacketVideo OpenCORE:; % £ Fhvi FI RO 4. #1
s 2Rl ], A SRS BB O . gntidig L E i MPEGA,
H.264, MP3, AAC, AMR, JPG, PNG .

o Surface Manager - X B/rn T RAEREHE, HFEANZANNHETHR 7T
2D #1 3D EIZHI TR & .

« LibWebCore - —AN5HH web I Y25 51 %, S FF Android 3% 2% A1
— AR web FLE

« SGL - JEJZH] 2D EIE 5] %

« 3D libraries - 3T OpenGL ES 1.0 APIs Sz8i; % nJ LAf# I AE¢E 3D
I CansRnT D BeaE 8 A m AR A ) 3D Hohni

« FreeType -f7/& (bitmap) Fl%&E (vector) FARE IR,

o SQLite - —/NXTRTAMNHET T, Ihagukshri i o & 25 2 5
%,

Android B1TFE

Android B T — MZLE, ZZ RS T JAVA FFEE S L ER R ZHT)
At

> Android B HIFEFEE S H R PIgAT, #IA — MG Dalvik
KERL HLSE]. Dalvik e it Be— M54 7T BL RN i Aotz 17 2 A LR 4t
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http://www.chinaup.org/docs/devel/resources-i18n.html
http://www.chinaup.org/docs/reference/android/app/NotificationManager.html
http://www.chinaup.org/docs/reference/android/app/Activity.html
http://www.chinaup.org/docs/intro/tutorial.html
http://www.chinaup.org/docs/intro/tutorial.html
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Dalvik FEHLIAAT C.dex) [ Dalvik FIHAAT 30, 2% SO0 /N P A7 A Al
T Ak R BB EE T A0, A SRR 1 JAVA ik s, 8
Jailid SDK ) "dx' T HFZ LA dex # 3 R WLIAT .

Dalvik EEUMLEIR T linux XK — L ThRE, LEAnZRAEHL I AT A7 2L o

Linux K%

Android [F#0 RGRSGKET Linux2.6 W%, tnestt, WS, e
R, RGPS EAE T . Linux A% R AR R AR AR 2 1A] O %
=8

TN ﬂ:ﬁﬁ
2ZIE SDK
AN BEAN BT 2235 Android SDK LA Ui fa] 8 & VR I T &K A5 . I SRR IE %

H R SDK, R0] LA N H FEREAT T4, SR 5 Bl 22 5OR & S ] 22 4,
BeE, Jf{¥HH1Z SDK kA% Android N HFET

T# SDK

Tr %2
SRR % P S LR AT e T, T ARG A 0T, 97 B 7 B SDK SR,

RGMBAFFRR

F Android sdk 4GS A1 T BT & Android SRR FE R 75 & & 10T & L BL &
TP, Wik
i B BRAERG:

« Windows XP I Vista

o Mac OS X 10.4.8 B HE mhA (I x86)

e Linux (Linux Ubuntu Dapper Drake hgAs2Lillixt)
T % FF KRB

« Eclipse IDE

o Eclipse 3.3 (Europa), 3.4 (Ganymede)
Eclipse JDT #fif (KZ%i/¥ Eclipse IDE f£1%)
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http://code.google.com/android/download.html
http://www.chinaup.org/docs/intro/upgrading.html
http://www.eclipse.org/downloads/
http://www.eclipse.org/jdt
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WST (F]#%,15 Android ZmE 45 1 ) B8 75 2, & #6 & 7£ most
Eclipse IDE packages )

o  JDK5 #% JDK6 (R JRE &A1)
o  Android Development Tools ##iff (RI ik )
o AFZE GNU Java 4iiF 2% (gcj)
o HABTFREHMEIEL IDE
o JDK5 ik JDK6 ({Xf JRE %)

o  Apache Ant1.6.5 B EE A ( Linux il Mac 385 F) |, 1.7 5
B kA ( Windows 355 )

o AFZ GNU Java % iF 2% (gcj)

E: SRR R F OS2 T jdk, EREE R FTHTVINERA S . bR
HEEAL linux AT REASH jdk 1.4 5% java K gnugeidas, Adroid FFk
FEAN SRR IX PP R A

Z3 SDK
T#5% SDK J5, 1.zip SCEMRIE SR B &5E 60 B, BRI T, SDK St

fifJ 5% android sdk <platform> <release> <build>XffH#. XX

HIEE tools/,samples/%.

THER ARG SDK 5 3R A4 7 AL E — ZH{R2%E Android $fifH 1
i/ SDK LEL, 50K 75 2251 XA SOk

PRI LA N SDK tools HISCHE IR A BIRIIM A B, 0 EATE, tools/
AT SDK S,
o Linux 3585 &i&~/.bash_profile 53 ~/.bashrc SCfF. K E|IFREA &%
BT, NN tools/MLaX B E. WIRRARNZEE, IRFEEHRM
—17:
export PATH=${PATH):<your sdk dir>/tools

o Mac 5 fE/RE) home SCAF I BT A4k .bash_profile, #AJ5F1 linux —
FERCTE . N2 AT A bash_profile S0, AR BAGEE— N HT )
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http://www.eclipse.org/webtools
http://www.eclipse.org/downloads/moreinfo/compare.php
http://www.eclipse.org/downloads/moreinfo/compare.php
http://java.sun.com/javase/downloads/index.jsp
http://www.chinaup.org/docs/intro/installing.html#installingplugin
http://java.sun.com/javase/downloads/index.jsp
http://ant.apache.org/
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o Windows ¥ 8¢ I, Adi AN, JREFEVE. AR ITEY, R
AR, HONTEAEHIL, EARGAEAR H BOdAR (Path) SRR

tools/ SCAFRISERHAZ,

Wi tools FMRHIMEIAEH, XAEARA] LLiz4T Android Debug Bridge (adb)

AMEA tools Maps, MAFEMATZEREY . FEWHKE, WRIETH
PRI SDK, 7 BEREAR 1 AR ML IA AR B 58 2157 A7 B

3% Eclipse #H{E (ADT)

WRIREA A Eclipse IDE {E 47 & Android B 388, RAT DA% 2% 57 HF
Android T &1 T. B3 FH 4814 Android Development Tools (ADT). ADT {1,
SRRy Tk, EaE, @7 MK Android FEHRHE, HEE L.

WMRAR 7~/ Eclipse IDE, A F#F1723E ADT #4F

RIS ADT i, 1 TIRIRN1% B Eclipse A P32 4%

Eclipse 3.3 (Europa) Eclipse 3.4 (Ganymede)

1. JFi4h Eclipse, 2AJ1E#: Help > 1. 23 Eclipse, %&£ Help >

Software Updates > Find and Software Updates....
Install.... 2. EHBUOCHEHER, Sdibrg
2. XHEHEHILE, i&#F Search 7 Available Software.
for new features to install i 3. fii# Add Site...
L 4. TG
3. riii New Remote Site.
4. FERENEH, IR R https://dl-ssl.google.c
%5 (4 Android Plugin) , #i om/android/eclipse/
AN AR
i OK.
https://dl-ssl.google.c 5. RETWHZRMAKME, ReE
om/android/eclipse/ B A, B R
Developer Tools 3 i
it OK. Install...
5. RATLUR BE Kol R A0 2144 6. IEHTFRMZEED, kb
FHRTOMHEHE), il Finish. "Android Developer Tools"F!
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http://www.chinaup.org/docs/intro/tools.html
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6. 1F P ZLE BXiEME, % "Android Editors". Android %5
BHE%EME Android Plugin > FRRFME R AT, HEFRATTHERE
Developer Tools. ‘& ¥ < A, WRIRER s, T
% "Android Developer T3 21 (1 WST it midh
Tools", #1 "Android Editors". Finish.

Android ZfH 4% 151 A2 T 7. H#J3 Eclipse.

1, (EERAVEE 2T, R
e A, T AT IR B WST
. i Next.

7. BRBFRTYML, ARJEIEBERERZ
VFRI B, s Next.

8. i Finish.

9. ADTHMHFREZL, R LLE
t“Install All"R 235 fir g 2R .

10. #HJ5 Eclipse.

# 5 2 J&, update your Eclipse preferences #5171 SDK 3435

1. #%# Window > Preferences... KT @M. (Mac OS X:
Eclipse > Preferences)

2. M HER Android.
3. 7EE A s SDK i Browse... S5 A7 SDK SCfF%,
4. fmii Apply, )5S S OK.

ADT T3 GRE
| fRUn 4z B DL PP IR R 3 ADT A S in), X B — e iy,

o TEFHIUN, MM FET HibE URL A http, MIE https.

o HIRARTERT KSR T (ARl kRS € /R Eclipse FI/CHL % B &
i&. ff Eclipse 3.3/3.4, {RAJLAMZ Eclipse S HELE: Window (£
Mac, Eclipse) > Preferences > General > Network Connections
WHRTETE 223 T30 ADT 481431 Eclipse, 3% B8 W1 R B 25 B8R MR HEL I T 80T
LREAT A
1. T#LADT 453 (AEIE).
2. FEIRERIN 3R 5 — A S — 2P (0 k).
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http://www.chinaup.org/docs/adt_download.html
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3. ff Eclipse 3.3, riii New Archive Site....
In Eclipse 3.4, click Add Site..., #RJ5 s Archive...

4. W AR A T B 4 S

5. WS IPIFAG 58 I T AT AL .
RIS, AR AL IR LD R BRI R EAT B

®EH ADT

FEREE LR, URHLES E 1 SDK AT REM ADT 4G fE 2 34511, VR AT DL AR A 3%
M Eclipse B 55 ADT #ift-

Eclipse 3.3 (Europa) Eclipse 3.4 (Ganymede)
1. %&¥ Help > Software 1. ¥ Help > Software
Updates > Find and Install.... Updates...
2. #%# Search for updates of 2. EFHZI Installed
the currently installed Software.
features Jf ity Finish. 3. i Update...

3. W ADT W LAHUHT, iE#IF % 4. W ADT i HH, G
TG T At Finish.

1. i%&# Help > Software
Updates > Manage
Configuration.

2. JEIFSHIMIFILESE Android
Development Tools
<version>

3. Available Tasks F#%#
Scan for Updates.

ZRIEREW

Ubuntu Linux EEEWR
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o WHRTRER WAL E java fE/RIT) ubuntu ALAs b, T B AT AR
1R 5 B

o https://help.ubuntu.com/community/Java

o https://help.ubuntu.com/community/Javalnstallation
o XHH java Al Eclipsed K% 3P0, Jt2ed Android SDK 1 ADT Fiifs.

1. WRIRVRIF RN EAE 64 A, IRFHEM apt-get %4

ia32-1libs fi
apt-get install ia32-1libs
2. T—&,%% Java:
apt-get install sun-javab6-bin
3. Ubuntu B&EHEZRIAEHA B Eclipse 3.3 A T4k, [FUbIRAIHE

1R M eclipse.org (http://www.eclipse.org/ downloads/) F#. #il
i Java 3¢ RCP K AS[¥] Eclipse.

4. FESRATTH A SR AP POk 2% SDK AT ADT #fifF.

HABRRA Linux HEZFH
o HWIRIRTEZZEE Eclipse H) ADT Jii {18 23X Mk

o An error occurred during provisioning.
o Cannot connect to keystore.
JKS

PRITE KGR TE S UL, %3 Sun Java 6 A LA JLX A~ i),
IR 5 VR P ELRT 223 ADT 4difT

o WR IDK &L BRIIT K BN b, 1H#E HRRCAEIX T TS 51 2%
HFELHIH, AL Linux &5 jdk1.4 80 java [f) gnu Zmi¥as, PLE &
Android 437 HF
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https://help.ubuntu.com/community/Java
https://help.ubuntu.com/community/Java
http://www.eclipse.org/downloads/

Guangzhou University LEREEWY)

¥ SDK

AAR R B ST SE IIT A AN, I RE e 2 SDK o hiig iRk cs
L T CARTARAS ) Android SDK, 75 B ff I A5 7

N T BRI N R T RE S HE 2% android1.0 &40, &7 B3 SDK R B
[ AP1 2 HEEIAT (1) android BN AIRESF, DL 2548 8 58 X — 2t A

TIHH SDK

%k SDK I 2] — N2 E .

fie B E) SDK LU, R8RSR T ERAE

o BEERVRAOISAIL A 0 H s

T #T ) SDK WA kA, — Sl Nesae 1o BRI AT AR A AT DR AT HO A
PSR L IAE R . FTIF— 8 G124 m M34E SDK Hifjito ols H k.
J2 BRI 288 wipe-data it 1% T
Windows: emulator -wipe-data
Mac/Linux: ./emulator -wipe-data

o  HHEH PATH A& (Mac/Linux; A ik )
WERAR LRI B PATH 28 & 48 H) SDK tools H 3, A4 750 2058 57 DA

fEM#r A SDK ). E.g., .bashrcor .bash profilefile:iexport

PATH=$PATH:<your new sdk dir>/tools

¥ ¥r ADT Eclipse

WRELE Eclipse FAFR ADT #fifh T &, 15 1%I8 R 5120 B2 250 R 4 41 UL e BT
] SDK.

Eclipse 3.3 (Europa) Eclipse 3.4 (Ganymede)

1. 1%&# Help > Software i%£#¢ Help > Software
Updates > Find and Install.... Updates...

2. i%&#¥ Search for updates of 1% the Installed Software
the currently installed tab.

features Jf xith Finish. i Update...
3. WHEALf] ADT A3k, % BT ADT G5k, i3t s

=

N

> W
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http://www.chinaup.org/docs/download.html
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3 7 Finish
4. )3 Eclipse. 5. #HJ3 Eclipse.

BHEBhZ )5, THER Eclipse W E 18I SDK H3%.

1. %# Window > Preferences... to open the Preferences panel. (Mac
OSX: Eclipse > Preferences)

2. #%# Android from the left panel.
3. XFEEMmMRH SDK EhL, it Browse... 73] SDK 1 H 3.
4. g Apply, #RJG OK.

EMVANEY e o2

B L AR P 28 EAT 2 BT AR L s 25 44« ADT A0 ant Jy2Eali T & T
BASCFRX —2k, e i@ — MR KEY 2 apk SCHFRE R HdE. N Tl
BX— 5, gmik LA AHE/E JIDK 1) Keytool £41i& —4 keystore FlH7 & —
A EHIEI A 2 RS — S key A7 — A SN 2 AV, infranE e, S
e 28 AR N FH T
T HARELA, PRNZTE SeiiA Keytool XF T SDK f4m 3% T B2 3. 78
REHIE T, AR0T LU JF) SDK %1 T B 448 £ Keytool, @it i% &R J
AVA_HOME A EREMN—NEER IDK. 7H4k, Edn] LN keytool (1)
JDK WA F 1) PATH A2 &
WERARIEAE S K Linux () — N RcAs, IRIEAE A )72 GNU (1) JAVA i, 15
i PR1% R GE IEAE A8 FH 1K Keytool 1) IDK A, TiAS 218 H gej, Wik keyt ool CL4
EIEHIAR, © Rl BER TR MIAE— M58 2 /usrbinkeytool o TEXFHEFH T,
BB SR B bR, ARS8 IEFR Keytool,
RS FH I ant 4a iR IR 1) .apk U= AN E ADT, AR 0 37 7= AR 1)
build.xml 3CfF. A T EIX— 5, HPAT T AP ER:

1. {ER) android SR TA2 B, REIFFEMIER B 57/ build.xml ST A4

2. 2. is1T activitycreator , EHHiH B S AR R OUE B SCHFR

3. - exec activitycreator

--out vyour.activity.YourActivity
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http://www.chinaup.org/docs/intro/develop-and-debug.html
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e ATX 77 emactivityCreator A< H BN @8 ) Java U (B manifest 3¢
oz, ST AL L AELER) activity Il package. ()&, package Al activity
FEESAFAER . % T EAIE—/SH0 build.xml 32, BLE—ANEH H 34K libs™
W, XA HSORIE S =TT jar 3UF, X RARELEEIEAEH ant B4 B B A EE

BHEERNHEST

FOF R SDK LG AR iB B ARY, B THEZEART API 284K
1a 75 BT I AR AS LAVL ER A% 4k 1) Andriod ] AP,

— M52 H Eclipse $T & 151 H A B RN AT H ADT MIbric s ix.
MIXEL, ARA] LA R AR $A AR T and AP AR AR

RIS A AR A H AR SBL, 1575 1) android /NHBE S SR BB SR Bh
T HAh android ¥ & A 5.

WMRCEEN T —> ApiDemos FHFET, HAEBEEH SDK 17, 1HEFE
10 T BN AL 2 h T 1) ApiDemos A . TR 25 R, o (GBfrei#
% A piDemos) BB —ANE LR IR, WS RHE RSB HER, &
ABETEFK T IDE H122%% ApiDemos N HHFREIT RIRIS AR HIX A ) B IIE B o
FRAER

— IR ELE android IR IR R . B ESTRATITEIEE, miE,
17 AR android A% . B¢, fRtH]LAA Hello Android tutorial ¥ 46

%
&

FENE
1. fE eclipse EFF & android NP
2. FIAHAHIDE MTEFFR android N
3. HLMNHEFREA
4.  ApiDemo RHIEFFHB:
5 WAk
6. & b KRR RE
7. TR BTy
8. MEEE—I android NHREF
9. B android #£F
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http://www.chinaup.org/docs/migrating/0.9-1.0/changes-overview.html
http://www.chinaup.org/docs/migrating/0.9-1.0/changes.html
http://www.chinaup.org/docs/groups.html
http://www.chinaup.org/docs/kb/troubleshooting.html#apidemosreinstall
http://www.chinaup.org/docs/kb/troubleshooting.html#apidemosreinstall
http://code.google.com/android/intro/hello-android.html
http://www.chinaup.org/docs/intro/develop-and-debug.html#developingwitheclipse#developingwitheclipse
http://www.chinaup.org/docs/intro/develop-and-debug.html#otherides#otherides
http://www.chinaup.org/docs/intro/develop-and-debug.html#signing#signing
http://www.chinaup.org/docs/intro/develop-and-debug.html#apidemos#apidemos
http://www.chinaup.org/docs/intro/develop-and-debug.html#debugging#debugging
http://www.chinaup.org/docs/intro/develop-and-debug.html#additionaldebugging#additionaldebugging
http://www.chinaup.org/docs/intro/develop-and-debug.html#toptips#toptips
http://www.chinaup.org/docs/intro/develop-and-debug.html#building#building
http://www.chinaup.org/docs/intro/develop-and-debug.html#uninstalling#uninstalling
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10. Eclipse 15

£ eclipse EFF& Android MFHER

7EH eclipse IDE FF & android S FHF2IT Z 1, 1R E 2 A)E#— Android T.%,
FHET—ANESE, EERA UGS, 817, LA AR N
2T

LR B2 iR DA fE eclipse htH2ee | ADT 4, W RAREA %3,
WS ERMAHU T . 2% 223 eclipse #fiff (ADT)

Bl & — android T8

ADT it 7 —ANSEr B LA R, ARAT RAPRIE ) 61— S8 i) LA s AR BA AR
i EOlEE TR . Q0 TREMIPIRIN R
%&£ File > New > Project
1. #%# Android > Android Project, #XJ5#% F Next
2. EEETUH AN
o 1% Create new project in workspace, NZmidfaE—A~48
) TFE
N TFEAFR (project name) , FEREHAFEAIZFR (the base
package name) , LA Activity S5 F5. BLEIZE stub java SCA4:
LN FFET 47
o  1%&F% Create project from existing source , JNEH LI AE—
AT, InRIREY R 1T SDK LR BIRER, AT BAE A XA
I, NBIRE A7 SDK ) samples/H 3 F .
W ALE EE AR H 3%, il ok, a5 H Strh a8 ] i android
manifest 3%, ADT ¥ ARIHEGERERAEL, activity, AN R
SEZY I
3. #%F Finish.
ADT 2 AR VR I TR R AL O 3 A 08 1) SO RS9, anF
o src/ FLE stub .java Activity SISO,
o res/ BEYEICHFK.
« AndroidManifestxml T f&i& .

g —N a3
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http://www.chinaup.org/docs/intro/develop-and-debug.html#tips#tips
http://www.chinaup.org/docs/intro/installing.html#installingplugin
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REHSLE eclipse FIZAT VAN AR 20T, 1RBAUNERIE—NEsh. J&83hI0
TR E WA TAEE S 3, TR activity JT46 TAF, DL FHRIR LU ASADL 28 e 10T 55
12 IR LU T B3RO Eclipse WA B2 Fr 82 &3 Y J5 3 70
1. I EshmEM T A,
o  {E Eclipse 3.3 (Europa)fJiRAH, HIIEiLE+H Run>Open Run
Dialog... or Run > Open Debug Dialog... -
o  1f Eclipse 3.4 (Ganymede)fz A, HFiEHF Run> Run
Configurations... or Run > Debug Configurations...
2. (EILI T RERAIH|F£ 1% FF Android Application &4, Wi (E sy
AR new) BT —ASHTI R BN
3. HANJENIAAFK.
4. f£ Android /%59, W EFF AR TR Activity -
5. £ Target Fr%5r, W EABE R R BERE LML /M, DU H A AR AT A4
A JE BTN
6. &7 LAE Common FR%5EH % B 5E 2 [ 16 1.
7. 1% T Apply RAF BN E, 8E % T Run 8¢ Debug O .

24T MRS R T

—BHAR®RE T LR TREESICE , /RHtn] DU B8 B B3 BRas AT Al B A 2

FTo.

M eclipse T35, WIETHEMERE Run>Run 5% Run>Debug, JFiAiEITEH

YRE B0 JE B I

R, X EIEEE SRS T B H P R ol — E R A . BEA—E

%7‘ /£ Eclipse Navigation T HikFMFET (WSRA
VBSOS E AT, LS A B T R . WA RAE S ) I T A

LA G — AN JE B I

B AT BN FH R P il LT Bh A

JRENEAL A, AR A T IRIEAT

o MPRLFE, MR LR EERIERE DABSOIRAS, BEB M. EEI
ay LGN HART

e RunitIi, HIRIEITIET

« Debug f£"Wait for debugger "1 T A #2728 fa FT R & 10 I06
Eclipse Java i #3 FIFE 7 CHK
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http://www.chinaup.org/docs/reference/emulator.html#startup-options
http://www.chinaup.org/docs/reference/emulator.html#startup-options
http://www.chinaup.org/docs/intro/develop-and-debug.html#launchconfig#launchconfig

Guangzhou University LEREEWY)

FF HAth IDEs M1 THEF K Android B HERF

I H RAME 22354 ADT #8441 eclipse Eclipse with the ADT plugin. kI &
Android 2/, XAMEEE g, build FRRIIEESERE] IDE L.

SR, AN RARAEAE AR IDE EJFRAERE, #ilan Intelid, =& 1% ADT 45
f11) eclipse T LL. SDK $24t 7 22%s, Jmid, PR HET L0 TR,

B —A android T2

Android SDK %~ activityCreator (27, E¥ N LR =4 LA stub SCHF
F—A~ build 3. URAT ELAHIXANER P A3 — N 8 Android T RE B FEHLA A
i Fa)g TR, 0 SDK FEEHfF. X Linux Al Mac #4t, SDK #2fit
activityCreator.py,—> Python i<, Windows |-/l & activityCreator.bat —
HEACFERIAS . o 2R &, kSRR,
¥ DL R AP BBIZE AT activityCreator €)% Android T.f%:
1. fEm2AT F, PI#3] SDK R tools/ HE T, NIRM LA X8 —
Hx. WRIRZAENARN Eald TR, VIHIAETFHRERT.
2. 1217 activityCreator. fEAar 24T T, MRAZITE E T2 G IR L IE NS EL
SRR A — AN TR, XA RAER NS B R4 R stub R A
Ao R RAE A RS EOVE TAR, D2dE 5 TR Hodr—A Activity
KEIAIR. a2 IH EA A4 «

o  --out <folder> ¥EHH H 3. BOEM THd Hx N4 H

Ko QIARARAE N TR SCAF QI — AN H 3¢, Al DU RX AN IE TR $E
A .

o --ide intellij, fE—NHHIIHF AR Intelid IDEA LTFEC

(G
XA T

~/android linux sdk/tools $ ./activityCreator.py --out
myproject your.package.name.ActivityName

package: your.package.name

out dir: myproject

activity name: ActivityName
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~/android linux sdk/tools $

activityCreator A4 Bl LA T A H S ((HEARRES OA ) -

e AndroidManifest.xml F£/FHIE AR, FIR A TR € Activity 25,
e build.xml —A~Ant X, HRIEIFHFT BN FHFET

e src/your/package/name/ActivityName.java RTEEHIHIA
Activity 5.

e your activity.iml, your activity.ipr,
your activity.iws [only with the -ide intellidJflag]intelliJ
TR

. res/ “ﬁﬁﬁ%

o src/ YEIBHZR.

e bin/ build AR H H .
BUE AR AT DR T RS R BRI )5, (HARACAE, 2 tool/ SCAF 3 1 Y
adb FEFR SO RIE BB AS o BRI AR A ZEAE /R TAEMBEAN tools/ U A 2 [a]
I
IRPR T EORE A28 SDK A3k, BOVERITWIgn i MIA .  CREEHT build Z |
i 25 HR SDK AL 42D

ik android N HEF
fi Fi] activityCreator 2 ) Ant SCAFE build. xml 2 3 A2 7
1. WSAREEA , 1A LLE T Apache Ant home page 52l Ant SCf: . 22358,
A E EAENRI T HAT STAF R AR T .
2. MY Ant Z BT, VR JAVA_HOME HiEA &, 32 % E N IDK i
IR

JER: f£ windows [, JDK ERIAM 2205842 79" Program Files", X/
k251 Ant RIGG RDYRRAE A 254 o AR XA )R, AR AT BMRIX

PEfE e A & JAVA_HOME: JAVA HOME=c:\Prora~1\Java\ %
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M0 87 B AR R TV 2 4 IDK B WA TAS I H K T o 0.
c:\java\jdkl.6.0 02.

i AR B U AR TR — AN TR A T
2.

HLAE AT B fREG TREIEAT Ant 4% SciE, L 7E buildxl [ SCfEsk
HIN ant BITT, SEUIEHUR SO BRI, M EEANEIT ant, EHE
5T 521102 PRV R 4T BMEE dleploy.

Z4T Android B
BAT AN R IR T AT adb T AR apk SO I SR, 2 1
/data/app/ B3 T, RIEWTF I/ 4H.

1.
2.

4.

RS (A 447 NI24T sdk H 3 K filtools/emulator) .
RS U 0 31 3 ) R U AN BEAEAR T 18 4T IR AL f U 88 e 26 /2 7, o]
PLi% home BRI HART)

iz4T adb, %% myproject/bin./<appname>.apk XX ff. #ltn, %% Lunar
Lander 77, #4247 F, Y43 SDK H3% F K/sample/LunarLander 1
H3F, #iA././tools/adb install bin/LunarLander.apk

FERULE R, ST SATREF SRR, Eah i, & IR s iR i SRR o

AT
?f IS8

SR B Y Activity I, JRAT A T AR R BN R L AT, s R

EAE R S R SRR SRS . DU B 8 AT AR AT 5 )

i A

AESE4 [ B £ manifests.

AR IR

AR R T R E ARG (Bt CPU M) | BLRAnfTH
IDE AR LIB AT R T Sk

{871 eclipse f4TT BLE SR A (LA DL AL L IDES SR U7
U A B

1.

JE&h Dalvik Debug Monitor Server (DDMS) T.E , ‘&7 IDE FIEHL 25
2 A v I e R R 55 B A . ?
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2. W EBLA R AL B I a0, S5 2 EE BN EUE A R R -
W, RZ AL T DDMS el LU A, flanisidlss - 2R CPU K
AR, B0 BRI R AR .

3. BiE IDE, f#i{5iHiR IDE 5 8700 i 1 5<% .how to set up Eclipse to
debug your project. £l & LLFEE .

Ac & IDE B hnif s

DDMS A5 95— /NI HLAMEL — TR I3 11, 3/ 1 7E L 38 P LY
HE). R AU IDE S5 CRERIAL LG RS A B s 1) ek
A BR I3 1 8700, KchE AT LUK IDE SEB:FIBE L RUFIZ iy (A
¥

f51f) IDE 7 EAEGS KIS IR IR, BReIOsR, JFvriit:
W, RAEERE, RN ORI B R TS,
PR 58] Eclipse MBS ATEAT, FTLAf A B AEHERE 2 W B ELI 4.
PTEE IR RE, S0 2 TR AT I AL FE S VA B R RS PER
BB . WRIRIORLF A TR RS, KT LR RSB e, TR
oI, S S LA LA

DAY e

Android RAERITE MIRF AL T4 A Re s, R BETHNIR %4,
RGH AV ZIIBAT IR T - AE RBIIRIE & B &, 2% android R4t,
XARIEH . ST LR, E RS ECE SRR s AT AR T 21, R AU AR
N R W E %4 .
HLff android F2P A M EE LA
o FTAMEFTHUAEL, WAEWEALNET, RAKARELE.
o AREMEFH AZEBUF BB IRIINHRT, DAUE T EUFRBUZ M .
o RGNS TE 22205 BN MRS 44 0E 15 16 R0W, an S8 FHRE P 28 4 72
TEZHReZ JaA B, T2 N AR AR AT LIRS JE o
o ARETLUME F AR T B-Keytool and Jarsigner-A: s 4H, K254 N LT
[1).apk SCH.
Android SDK T E AT AFE B URAE RGN 25 N FE P 2544 . ADT A0 Ant i 15
T HAAE T WA 4 4 -debug B3R release fi

o debug T, FmiF THEAMH IDK F1ifidE R T Keytool idid A%
AN R O AN . BRR G PE RIS i, TR debug #8254 M
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FHFE 1) .apk SO RN 52 TN, TS 75 BEAE AR IR G PR IO IS i 42
TNARERT N 25 RN 25 4

o YR TR CAHES release T, YRAILATE release HEF0 T 4i%.
release U, T HYFER Ao .apk X254 . -7 2 Keytool A&
RCE AR E S, B IDK H R Jarsigner T H.25 . apk 324 .

BHERETE

NT SRR BB, R LB € Keytool 75 SDK 2 3% T 2 & B 21
AR Z B0 T /R AT LAY B JAVA_ HOME 85745 &, 451 SDK 4114k 3| Keytool,
BRI LAE PATH A2 &8 i Keytool () IDK kA

WIERARAZLE linux AR, BAERE Java Gnu Zikds, TEHE RGH M

& Keytool iR A1) IDK, TiANE gej AR . a5 Keytool L& 7E PATH H, B
BB 17 755 B lusribinkeytool. IXFHIEAL T, ZSLRF S ERN H brsgfeH JDK
T ] Keytool

Eclipse/ADT H 242

WIERARAEAE Eclipse TH K, H O B4 %% T Keytool, BRilT

LR 2 AT LAE debug AN 2544 1 o A URis AT R P I ADK 45 .apk 3C
12540, FFRBERIEES b XA TFERIRINENE, ADT &4 Keytool
£ release #ix N gmiFFEF, fF Package [ A 1% project A4, #%&# Android

Tools>E xport Application Package. 5 fR 1] LA i Manifest Editor, overview
U _F“Exporting the unsigned .apk™i&#: , FH ALY apk . fRA1F.apk
X2 )5, H Jarsigner KAk H CIE S apk U284, WREAEESH, IR
AT LA Keystore i 2 AN S G, IR COAH —NMEHA T, WALESH, Bl
Pl .apk U244 T .

Ant &4

WIERH Ant 4 it.apk SO, BCBARAE H SO Y SDK H1 8L {5 1) activitycreator
T HA R build xml SCAF, BRI GL R AT LA A debug 254850, MIRIE1T Ant
XF build. xml 2327, build BEARE A s % B8R %5 FH 9F 25 44 .apk SO IXER 7 A
i O E R IR IR B A
release #X N IFFET, RFEEMOIVRLE Ant iy 2 HHTE 2 %P H hrrelease”s
fian, i AE bulid.xml Frfe Bk Migfr antA LT g4
ant release
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build JAIA g A5 7 N I F IR A %544 . dmiEoc.apk SCIF R, FRFEEH Jarsigner
R E TR % apk X4 . tREA Y], VRAT LA Keystore 81 @ % HH AT
L. WRCEA NEHT, MAILEH, R g .apk SUFEA T .

WREBHARR

H2ZUET H TH2)7 1) debug #0F (BRIAEHL T 72 Eclipse/ADT F1 Ant
builds) |, H & A g i [H) A —4F 1 R

PHER RN, Mo AmEER.  And FHHRZRUT:

debug:

[echo] Packaging bin/samples-debug.apk, and signing it with
a debug key...

[exec] Debug Certificate expired on 8/4/08 3:43 PM

£ Eclipse/ADT &, {RAILLE 2R EE R o

FEE R X A ) L) T B 5 IR debug.keystore XCf. LinuxMac OSX FixA4
A RAFAE~Landroid T, windows XP &, MHFRfF{E C:\Documents and

Settings\<user>\Local Settings\Application Data\Android.
windows Vista N SCHFAR-IFAE
C:\Users\<user>\AppData\Local\Android,

N IRGW RIS, G 1 T EORE AR OB S BN

TR SRR T & %A% 13 F & non-Gregorian locale, 4 % T 520 % AR 1 A4

A AR R E T, R R EIR S5 R RN . ST RER,
HZ B MEARAE B 1 can't compile my app because the build tools ge nerated

an expired debug certificate.

5 F ApiDemo 761 B R

Android SDK 3% | —E /R BIREF, MA15IE |2 IR & API I V.
ApiDemos B PR AT 2R ERAU A, BT LMK AT DLJS SR AR, 7 32 I [ 1)
I FH A 7 i LT e

R AT LAFE<SDK>/samples/ApiDemos 1 # 2|JiY, AIHEEE, %> Demo
IS TV
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WERARIEE, PRIE R LUK ApiDemo I RBIFE PR A — A TRk, BHof
ERES FisfT. SR, FERXRZ AR E Se B E 3 /i C 4 % 2% 1 ApiDemos.
AR AR FR Z 0T 22 B AR AT B4R KA g AT 8 iZ ok ApiDemos, 14>
PR

KT WA EIE AN E 3E ApiDemo, 7] PAZ7% | can't install ApiDemos apps in my
IDE because of a signing error X 4R 5 AT AER I H KRB TAE 1.

TR
Android 24757 ) — 25 T LA B R AR 7 F AR
. DDMS - AMEFINFLFF, &3 HFl e (L RITLIZE IDE 28 IR
REL R |, SCRRTIB I BB, SRR E ., LU 2 3t
Be. IR AT LUZST logeat FEHI3RAE Log £ . Mkl Ema BT 215 4.
. logcat FERKRGHE ., IKHe(E EALKE, LA A I R R 7
DL H A5 B 384T logoat, il B2

o I/MemoryDealer ( 763) : MemoryDealer (this=0x54bdal) :
Creating 2621440 bytes heap at 0x438db000

o I/Logger( 1858): getView() requesting item number O
. I/Logger( 1858): getView() requesting item number 1
o I/Logger( 1858): getView() requesting item number 2

o D/ActivityManager ( 763): Stopping:
HistoryRecord{409dbb20 com.android.home.AllApps}

« Android Log - #it g I log XHHEE HEZR. WRIR7E DDMS I
117 T logcat, VR PASE [ B IX L85 B . AEARIIAIS SN logging 75
EHRAL . AT log 38, ARFT DAARE VR AESRAGE S5 00 B AR AN A
Log.v(verbose),Log.d()(debug),Log.i()(information),Log.w()(warning) &%

# Log.e(error). k7K log 8 2 Log. i ("MyActivity",
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"MyClass.getView() — Requesting item number " +
position)
fR0] LLH logeat [ 1521% 2615 5

o Traceview - Android ] LA pR £ (1)1 FH R 400 DA S 3 FH e TR] O A7 31— A
log SCfEH, R LU B %% Traceview BETVEMNE . HEEHEE
BIXAEE T 1) 3

« Eclipse plugin -Eclipse ffif#& 17 M 4%=1 T A (ADB, DDMS,
logcat output, AR IFLEINEE) , miEREEREZELR.

. Debugand Test Device Settings -Android 7~ TR ZH ¥ E,
W CPU ff A1 ik 2, 2% R Debug and Test Settings on the
Emulator

Also, see the Troubleshooting section of the doc to figure out why your

application isn't appearing on the emulator, or why it's not starting.

WAk, S0 BEXMEMR X — SR, AR A 1 B RE P AT 4 5 LR R 25

£, SO AT G,

W& LR AR 3 E
Android R VR E 2 A8 DAER IR AR T . SRR 1 ITF R B,
A LLi%&#¢ Dev Tools>Development Settings. 8 LA R BB T 4T 7T & B 7T
(BHPZ—) -
o Debug app EFFERWFIXIIFET, RATFERBEIXRKBARASE, H
XA EAHHAMER:
o i1k Android 75 R 1 T AT A B (145 B B P AR
o RVFRES Wait for Debugger &R #5575 5h, HEH AL
PR | (i R A4
o Wait for debugger  FHZEFEFINEE 2IOCHL E s . XFEARY LALE
onCreate() 4 & i /5, IXAER Activity ()5 hiE R R B2 . 4Rk

ARIXANEIN, AT AT IS AT IR P LB B R0 . ik IEHE, fR2A 20N
LA BREFE NIRRT . XFEARS F SN waitForDebugger() /&
— R

« Immediately destroy activities 5 &4t X E activity 1515 T 5%
‘B. (tun Android 52 [EIU N AF). IXANFEN
onSavelnstanceState (Bundle) / onCreate(android.os.Bundle){th5 %45
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I AR A, A T DUAR 25 e 33X AN e T ] BT R AR 22 1) R, DR AAT ]
B RAFFR T IR

o Show screen updates & H X ANEDIR], B EAR A #E B 22 (KR P X I8
NI AL 0T R R A EZ 2 BIRA H

« ShowCPUusage 7EBtH Il Er—A CPU B, Eox CPU i
L. LG EREN CPUMAZR, NS Bon B i ki
CPU I IE] . vER: —HATIHRIIAe AR, BRAREHT S shid,

e 277
« Show background %% activity i 5 BRI BoR T FHEAR, 1X N0 H 7E
IR A 2 KA

R e L Jo X e i E AL .

T v A 52
e A R
MHLZS L3/ HERE(, 41T A% adb shell, FI"ps"ir &+ 31 {40 2
HIHERZ, SR FRKINS", R HUZER SR TE log SO
D BRR LEFARER
BT LR R, Bl CPU MBI, LU 2R B K

. A PIETF KW E & LT F RIS AIX 6 e . Setting debug and test
configurations on the emulator."F A VE4HAN4H .

YR LU Dalvik Debug Monitor Service T B3RS HIRSE R . iF
%2 adb /44 dumpsys and dumpstate
REER N BEFIRESE B (dumpsys)

AT Ll Dalvik Debug Monitor Service T. 23573 dumpsys /5 8. &
% adb F1 44 dumpsys and dumpstate .

RBLRERER
fR7] LA Dalvik Debug Monitor Service T B3R IEL &S E . #
Device 32 . %" Dump radio state”

1o 3% IR ERBE

YR A LATE activity Hif i 1 F android.os.Debug.startMethod Tracing () K
055 BR B DL R B BRSO - VRN 2% Running the Traceview
Debugging Program .

LR T LB
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BOAEOL T ARG A LR ELEIE (BIRMRZ) o R, ARAT LU NI
im0 IO AR -

adb shell
logcat -b radio

1217 adb

Android H adb TR, fligft 72 ofe, QBRI L 4F BB

Wb, AR, ERRLEE FIZ4T UNIX shell.  # Using adb.
RSB E

Dalvik Debug Monitor Server (DDMS) ] LAJIEURRFL 28 B 52485 K

5 A R B3R
Android Jy75 fEAE S0 7 IRAE RIS, Bl utlLog 1 Debug

HPEREE Anroid M HRER

Android ZL3R4 [T 1) 4 13 T B v] DL IR 0 G 138 05 YR SC A AN B R 5 B AR5 23
BRI, AR AUNIRI N AR P & — & T T B A 85T

1] Android 2 PR 2s a0 RALEE,  4ni XML A1 A B Y5 SCF 356 2 458 1 4
HAE A ZmiFELr 1 Android B FE T2 —AN.apk E46 304, B A .dex X,
TR, 5 data SO, DAAHAR SO . fRAT BB scrateh, B YR SR i
—/NEIE R Android TFE.

Android H FiAS SCRFITEA HUARHS T & 28 =07 N AR

FL R HERE I Andriod B FHFE P & 774 use Eclipse with the Android plugin,
X FIE, 1217, P Android B FHFET o

R ARIEE HoAh IDE, Android provides tools for other IDEs 7] LA%i%iz 4T
Android MR, (HAEMATA IR TEE.

% H—/> Android MFHER

ot — N A E LA IR AR, R EEHAT adbrun adb MiFk.apk 3¢
o .apk SCHFFRAE 2B I Ak B AS F . {4 adb shell 2 A1 £ 1)
shell, V)#:% data/app HX'F, H rm a4 apk ¢4 : rm your_app.apko
REEERE RN A .

241107


http://www.chinaup.org/docs/reference/adb.html
http://www.chinaup.org/docs/reference/android/util/Log.html
http://www.chinaup.org/docs/reference/android/os/Debug.html
http://www.chinaup.org/docs/reference/glossary.html
http://www.chinaup.org/docs/intro/develop-and-debug.html#developingwitheclipse#developingwitheclipse
http://www.chinaup.org/docs/intro/develop-and-debug.html#otherides#otherides
http://www.chinaup.org/docs/reference/adb.html

Guangzhou University LEREEWY)

Eclipse £15

7E Eclipse LHATER java g

£ Eclipse I, HFEFPASE W s AL IR R LR AT AR AR . B0, 7E— A& 47 Zip”
TR SRR B, IR UESRE A EE S, ST, (Rt HITIER

AT W, Wi\ android.os.Debug.startMethodTracing() , A

4l dmTrace.

RS HAT & 1, T3 ik Window>Show View>Display, 171 &~ &
M, —ARRR SRS . MARRARD, mRERcy, Bl Ebs (8
CTRL + SHIFT + D) a7, MRS fEPHELIER L histy, mixA&RE
W AEATEWT AL B H P IR . (ISR TR AR, RUIURBIAT
LR 15 4E Objectwait() 2 %A KD -

AR B AR AFERT AL, R AR L4 T (CTRL + SHIFT + D) s if T
— B,

PRAT DAy s ] — e v XA S0, %™ ALT +SHIFT + [a) B/ja) R 7 Skokek
A5 14 [X 45 2R )

NIRRT, BN A AR eclipse o HEIRINAE .

Input Response

zip (jJava.lang.String)

zip.endsWith (".zip") (boolean) true

zip.endsWith (".jar") (boolean) false

PRA AT AR FH B AR AEAS P 4l ABAT ARG . 7E eclipse SCRY AR
"scrapbook 5% .
F 311247 DDMS

BARHETE A ADT i/ FE 7, HARE R LLF3shig4T DDMS, fit & Eclipse
PIMEZE 8700 v O FVREF FE. HAeMENRE3) 7 DDMS) .
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B0 JUnit PR
£ Eclipse/ADT AR ] LAZEREF FR8 0 JUnit M3R2E, SR, RIS 1T IE % Z ji /R
W E T JUnit FlE,
KF e E JUnit FLE PR, SEIES WALMERE L@ | can't run a
Junit test class in Eclipse.
Hello, Android!
VERIT R, VRIS — B AR E BT K AESE S *Hello, World!"F% ¢ i 4 4
SRR T . 48R, 7E Android B, XAMEEE S, TIHRIIRG RN
o flEATH
- U
o J817{R5: Hello, Android
TN VR R R
o fHH XML #% Ul
o I TEE
o AMEEH Eclipse f##—/> T2
ARG

A THE
B — AR AR L TS, Eclipse 34 nT UE Android [T & 2845 &
REE—&3H Eclipse IDE (3% 2T R), 1767 E 2% Android
Eclipse ffiff (ADT). WIRIRESHERLY 1, AL BXHE.
B, R EX W A2 “Hello, World!" & AN KHER) 1 i -
1. {E3EH#rh File > New > Project F1 8 & — /¥ Android i H .
2. fEANE Android T B X 1 AE HLAH S T H VR4S B .
3. iR H BN USRI £ s — Se i .
KFEFTOL T, N3, AT gReS .
1. RIE—/#H Android I B
¥TFF Eclipse, #%&# File > New > Project #15£ Android HJ Eclipse K&
HRIERZET, B KX IEE R SA —H “Android”, X—IFHE—K
FI “Android Project”,
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£ New Project m[

Select a wizard —

[

- i

Wizards:

ype filter text

[¥]

% |ava Project
% Java Project from Existing Ant Buildfile
42 Plug-in Project
b (= General
< [=Android
b =C
b =C++
b =CVS
P =Eclipse Modeling Framewark Ad|

il Mext = Cancel

1% ¥ “Android Project”, HT—3%.

2. HETRENHRARE B
TP REMRRSHANEAEE, XEFMIT:
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£ New Android Project

New Android Project
Creates a new Android Project resource, q

Project name: |HelloAndroid

Contents
(®) Create new project in workspace
(O Create project from existing source

Use default location

|

Properties
Package name: |c0m.andr0id.he|l0
Activity name; |He||DAr1droid

Application name: |He||0, Android

@ < Back | Finish Cancel

T PRAESE TR RAFAEAR LA BTN H s B

e

%

1, AL 4 5 A (FF 2580 java wisis & ey 2D AR ATE

4 PAGH AL XAy 44 72 18] R o X242 BUEL I 44 PR A TG 31 H 304
P80 VRASE BRI AN 1 44 - 0 A At 22 28 AE R AL 28 B4 - A
M, FrL, AEH R B LA R AR . an B,
BAE AL 4 7 N com.android”, {EAR T B — AN A (19 2%
A,

S| SRR E B S 4 . e 2 Android EEH—

B TR —MESUGE — NS DR IR REPAT 2. Bk

% e, ATCAGUEE 7 S H XA R .
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T X f e A RN R 44 7
?
%

T % AE B "Use default location” o ¥F/RiEFEHAL B RAEWE AR
Hexx#H.

3. G HshERA
BTEARE, £831ER—1FK“HelloAndroid (7] LERFEE
HelloAndroid > src > com.android.hello 3 3]). #iX#:

public class HelloAndroid extends Activity {

/** ERE—RBORFEMA. **/
@Override

public void onCreate (Bundle savedInstanceState) {
super .onCreate (savedInstanceState) ;

setContentView(R.layout.main) ;

B, IRATABATIER T« A BRATET PR T, XHERATEEE
FREMERF. oL, T—2RRATH USRS

BT U

A FIIRAME SIS, JR7T LAZEARF HelloAndroid.java S BLARURE [R] 1 & 04
PATAIZAT 7B

package com.android.hello;

import android.app.Activity;
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import android.os.Bundle;

import android.widget.TextView;

public class HelloAndroid extends Activity {
/xx TEAE IR AR R
@Override
public void onCreate (Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
TextView tv = new TextView(this);

tv.setText ("Hello, Android");

setContentView (tv) ;

RN AREILEI TextView 4, ALK Ctrl-Shift-O (W2 Mac
A4 Cmd-Shift-0). X/ & Eclipse & FPHE R X2 2 SRk AR 1
SRJE BB AR .

7£ Android B, FH /40 H— SRR A EIA RZ R IR H K. — MR
AR R . WRIERE, FhEEAE, —ANCARE GRATEIFRED &
ATTRR AL B S A (XA — AN TR Y TextView. X BLEARU{TEIE TextView.
X B R0 B 8 TextView:

TextView tv = new TextView(this);

TextView #i& a3t /& Android £ R SCHYSEB, XA B R SUXBUE SR M R SE i —
AN, B RRAME B AL SR RS . B Se gk N BORLEE DL R S HUERFR N
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XAESI WM A F T .  HelloAndroid 252 3E3h— AN 12K, B —
AT, FAREEE this #AE TextView.
B1% TextView 5, MIATZEEREINE:

tv.setText ("Hello, Android");

XBERIEH
BAIBNE— TextView, KRG HIFE B RBNE. &a—Falik TextView 78
B ERIRHIK, (RIXFE.

setContentView (tv) ;

B H setContentView () {77723 BIMIEAN LI 75 2476 241 Ul EgidedE. iR
—MENABEHA XA TTVE, A Y4BT A R RS s A— DN T AR,
AU AR 7R — 26 30A, By DAERAT TR A B 1 TextView iE4% I

Xyt Android -4 B “Hello, World”, 44k, FATATLAE FigiT1B M.

AT Hello, Android

Eclipse HIffifH S RIFE TR 551817 . 1 # Run>->0Open Run Dialog % #..
(Eclipse3.4 x4, 3£#4 Run->Run Configurations) ] L& FIJ3X FE 0%
HE
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SEm R

£ Run

Android Application

|

Create, manage, and run configurations @

x

B

[ %@[E}:ﬁ"

e fiter tor
H Apache Torneat
[E]c/c++ Local Appl
&Eclipse Applicatiorn
EdEclipse Data Tools
B Generic server
B Generic Server(Ex
B HTTP Preview
 |2EE Preview
#l Java Applet
T Java Application
JuUnit
Jii JUnit Plug-in Test
Zs Jython run
Z- lython unittest
4 0SGi Framework
Z5 Python Coverage
Z Pvthon Run

4

Filter matched 20 of 20

Configure launch settings from this dialog:

[ ¥ - Press the 'New' button to create a configuration of the selected type.
['= - Press the 'Duplicate’ button to copy the selected configuration.

¥ - Press the 'Delete’ button to remove the selected configuration.

& - Press the 'Filter' button te configure filtering options.

- Edit or view an existing configuration by selecting it.

Configure launch perspective settings from the Perspectives preference
page.

@

Close

N4, % Android Application”, mdifER B (AR — KA EA AN +5)
5# X “Android Application”. 5/~ [¥1i£ 35 “New_configuration”.
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Create, manage, and run configurations
Android Application @

SEEIEEN

Mame: INew_configuration

t filter text
Iype fterte =] Android ETarget] = gommon]

= @ Android Application | | project:
@ New_configuratio I Browse... |

g Apache Tomeat
[©]c/c++ Local Applica -Activity:
@ Eclipse Application [= |

Ed Eclipse Data Tools

ﬁ Generic Server

B Generic Server(Exter
ﬁ HTTP Preview

& J2EE Preview

=5l Java Applet

31 Java Application

Ju JUnit

Ji JUnit Plug-in Test

Za Jython run =
25 Jython unittest
@ 0SGi Framework
Z5 pvthon Coverage LT

K1 I n | |

Filter matched 21 of 21 iterms

@ Run Close |

B2 TR ERE — A, n“Hello, Android”, #RJ51% Browse 1240 1% A/ 1) 3
H, IR Eclipse B 24> Android T H F B 4TI, #ic EEkFIER) #eF
S AR E BRESI IR, SREEYEN N RE R B . WIRAR
“Hello, Android”Ti H A —A, BRI ENENINE, SREIRATL4REE,
midi“Apply’$#%4l, X BAH AT
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& Run o
Create, manage, and run configurations
Android Application @

B 8[}:9'

Name: IHeIIo, Android

type filter text
I e =] Android - B3 Target] =] gommon]

<= d Android Application ~Project:

@ Hello, Android IHeIIoAndrOid Browse... |

£ Apache Tomcat
[E]c/C++ Local Applicar -Activity:

©Eclipse Application com.android.hello.HelloAndroid [+ |
Ed Eclipse Data Tools

[+]

& Generic Server

& Generic Server(Exter
B HTTP Preview

E J2EE Preview

il Java Applet

3 Java Application

Ju JUnit

Ju JUnit Plug-in Test

Zs Jython run -
24 lython unittest
% 0SGi Framework
Z5 pvthon Coverage =l

K1 o | |

Filter matched 21 of 21 items

@ Run Close |

KB ATLL T, flidi“Run™%4H, Android FIRRHLER R 3. — B BNMRIFE T 2
HI, H—V) OK, 1R LA F:
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EhHl @& 5:53 Am

Hello, Android
Hello, Android

X2 Android f¥1“Hello, World”, 2 AN AR R H0E ? T — & A TRAR B 1
MEE . SIREMTE 2 Android B, fRZ KILE AR5 A M H.

f# F XML ¥£ Ul

TRIIRI5E e “Hello, World” 45154 Y 12 BATFRON Al A2 Ul )=, B2
fREE g AV RA R Ul R S0 TR 21 UL, IR KL L8R
FERIILR . — /N 7 EARMORE RIS 3 . ARH 2 510k View iE
K, XHESSEC SR, IRIRIR 2 8] & A .

i Android JAt AR Bt — AN FTARAL Y UL R A T XML B9 i

PR S B BRI X BEAAS XML 30, B REB BINRNIA 52
JSA A R FR 2R

<?xml version="1., 0" encoding="utf-8"?>
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<TextView

xmlns:android="http://schemas.android.com/apk/res/android

android:layout width="fill parent"
android:layout height="fill parent"

android:text="Hello, Android"/>

i H Android H XML SCPFEEHZARTET K. W2 —SEhrid MRS, B8
Wl — LS. XA, B A E K TextView JTER M, IR
A UAAE XML 3P BAE AR R I 2 FE IR EI bR IL, X BB IRAEIR B E
SRS B e A4 7o XA SE A A5 PR BE 18 FH ) B 45 F RITE T RIE O 4L UL,
X AR X b (T AT, IRBEUSRE ULRIRE 7 2 4800 0T, SR L B IR
e -

EIXMFH, 44 XML g, FIH 2 o=
B iR
xmlns:android X 52—~ XML #4256, &% Android FF & L

BARUESE ] Android 7y 44 2 7] B — L3 F
J@M. 1EFTA Android XML 311 S04k i b 2
FIbR 12 6 20 A FH X AN TE

android:layout_width XA R T XA TR A A e
o FEIRANMEF A, AT I — M ] LA
b AN BERE, TRk 2 ill_parent” ) = 2

android:layout height | X/MHl“layout width"ZAZ, Fox b HERM

i

android:text EANEE AR RNE, EXMTH, A
ffi FH“Hello, Android”.
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Xahe XML AT R, ARFE EEIX AN ST A6 B2 TAEAR T8
Iresllayout Nt AT PL. “res”;&“resource” ARk, XANHREE TG NHER
TE AL . B . FRE . XML S

Eclipse ffiff AREIE 11X £ XML ST H ) —A o FEFRATT BT e, FRATHRA
BAEMHEE. AARNEIEEE, B HR/res/layout,gmtE main.xml X fF,
e b1 SCARSR TG IRAFE T

EMNARES H BT Rjava X, AR LB B A 18I F:

public final class R {
public static final class attr {
}i
public static final class drawable {
public static final int icon=0x7f£020000;
}i
public static final class layout {
public static final int main=0x7f£030000;
}i
public static final class string {

public static final int app name=0x7£040000;

¥

R.java & U BT BHIR IR 51 S (A € o ARFEARRD 8 IR AN R, R AEAR
I B B — AN 1 5 AR R IR YR . 7E Eclipse iXFE(1) IDE THE, X
A7 2O FARAD B 30 58 D BE I A2 3R 5 A 2, RUONIX BELRARPGELS e 1 fREE
R

AN EE S FEE RN EE AN N E 2 main” & “layout’ [ ik 1 25 . Eclipse ffiff 4
FEAR N T —ASHT I XML SO, SR JE AR Rijava ST, 445 i N At 55 I 2R
TREHE, KAILLE F Rjava 1E [F 5 5 .
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55 J5 A PR it 1 AR S A 1) XML A& X407 1) HelloAndroid ARS 224X %5 LR
FIgmit.  XANE BT S FREA, ReT LR, ARISARS IR
FA

package com.android.hello;

import android.app.Activity;

import android.os.Bundle;

public class HelloAndroid extends Activity {
/** Called when the activity is first created */
@Override
public void onCreate (Bundle savedInstanceState) {
super.onCreate(savedInstanceState);

setContentView (R. layout.main);

}

DR MOIX B, R TR ERE DL Bl A R 2 BARAT LA RS
H 2N TE I RE, R RIS SR A H B

MR A TERNR T IX B, GREEPATIRIAR - IR 75 B A5t 2 4% T SR e )
“Run’%4, Bi# 763 8 ik Run->Run History->Hello,Android.  #RF] LLFE
B MR, FZETE B —FE 3 s 3R RS R R g SRR BRI B R FE 1
iR

EHRZ I ERAE XML U, EREMz T, —F sl P80 nT B3k
REZER.

AR TR
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Android X} Eclipse 1 & K{d1: 1 Eclipse HAR T B4 &G MR . H TR
—F, BAERRE BN — bug. ARAT LGN T AR — A& U7R AR RS

package com.android.hello;

import android.app.Activity;

import android.os.Bundle;

public class HelloAndroid extends Activity {
/xx TEAE IR R R
@Override
public void onCreate (Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
Object o = null;
o.toString () ;

setContentView (R.layout.main);

EAMEHANAL SN T —A NullPointerException ZIRACIDE . W AR XS
1T, sERSER:
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A Sorry!

The application Hello,
Android (process

com.android.hello) has
stopped unexpectedly. Please

Force close

{%“Force Quit"Z IEFE 7 I pi i 28 5 .
N T FRERPRE, BE—WEAE Object o = null; ({EARIEATSHILN

FRICEEAE); SR 5 MBI $E Run->Debug History->Hello,Android i# A iR #%
o IRIN IR 72 ERE BB E 3, HRXRSEIRERIW b= . IR
A LLE Eclipse’s Debug Perspective B ¥ D HATUS, USRI ANFE T —
Ffo
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|J] HelloAndroid.java 22 - € main.xml a R.java - O

[»]

1 package com. android. hello;
2
s#import android.app.Activity:[]

& public class HelloAndroid extends Activity {
A% Called when the activity is first created. */
@lverride
public void onCreate(Bundle icicle) {
super. onCreate (1cicle);
Object o = null;
o.toString():
setContentView(R. layout.main);

A{E H Eclipse A& T

WIRARAME ] Eclipse (HtinfRE Xk H Al IDE T, 33 N A A SCA g 5 2% 5%
FHa AT TER) , W4 Eclipse BIFE X IRIEEER- o« AR L-EA 2 BFIRAE
H Eclipse Tif# 1 < AL D 6E

Android X} Eclipse F46 A2 Android SDK AhEI— AT H . (X4 Hn.
B, aapt, adb, ddms SE5E#07E HAMSCRY) Rk, X g T B A Ath T B 41
“ant"d RS SEG A E T RER

Android SDK . {18 — Python I¥] il 4 “activitycreator.py”, & ] LA ) 35 H
GIEEFTA RIS LA H 3. gt ant 1 1“build xml”SCAF . I1X R VFARAEH a7 24T
PRI TR IR E O/ IDE T HE&E K.

fihn, wigIERAINIE R Eclipse €& 1) HelloAndroid 35 H , &k a] UE FH Ay 4

activitycreator.py --out HelloAndroid

com.android.hello.HelloAndroid

Gk LRERIRHE, RigfTant™ 4, Aar I AT S, HAEDIn”H S B =4 —
A~ “HelloAndroid.apk” #1304, “apk” {2 Android [—AML, 4R 7] BA# A “adb”
TR I8 E AT -

WERABSRAG T ZA5 S, 15 e 152 90 ol 4 (At 1Y) 385 Ath SOy o
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Android . F & Rk
— A5 Android N FE A H AT DU A 28 A2 A4y i 1 e A -

e HB)

o BN

o JR%

o  HNAEIRMLER
TEVERMAZ, HAZTA Andorid B HFE 7 AL R X 4 N4, B Ln] R
FH 33X e 2H 4 1) 2H - T %
— HAREE 7RIS R 75 B A, AR N AZAE
AndroidManifestxml FF 51 HARAT.  XiE—A XML BC& SCF, e H e XN
PP R B A AERIThRe b B . XN RLIIN . FHEESI
Android manifest file documentation

VU 2 A B B T

E3h

W2 A Andorid N FEFP2AE, N AHFEFP A, — NS sIE e A
MBS B NESIAPSEIUN — DM MOLRISR,  IF B NSNS kK ok,
WA 2 Bon i E AR R P 32 0, RS i N . R
A& H1 22 e St o AR e B, — A SCAME SR VA — AN s RO B Y
WRANFNER SR, 5 A bR RS ORI BAE R N, R A&
BB S I E R A XA NI B AL NS, IRE S
SEHL A Bt 21— AN B 0T HLSE R a8l . AERREE TR 00 N AT i b 4
WV 2 ) b — AN B R s he AR [ - L ik F P AL P — 5Kk R 3z [a]

MO IR 1L

BITIF AW RN, 2T DR E VB IR I AP LR
FI 7 a] LUIE I [0 # 0] 21 LURG T T3 (0 o BATTAT UG £ R RS R — L3507 b
ORISR, AU Android 2 ERE S ST I AR 7 O B AEERR A

Intent Al Intent Filters

P Android 25 Intent HEATHIBES 2 EIYIH .  Intent 24148 N A8 Z A
124 o Intent Fid 2 1) P B 52 (1350 43 A2 S VE AN AE X L it « LR (R sh AR 2
A MAIN GESIITTS) « VIEW. PICK. EDIT &, 1 ah/EXT M R E3E ] LA
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http://code.google.com/android/devel/bblocks-manifest.html
http://code.google.com/android/reference/android/app/活动.html
http://code.google.com/android/reference/android/view/View.html
http://code.google.com/android/reference/android/content/Intent.html
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URI E TR R filin: EEEE—NMARBRT R, RFHEEQE—E1E
HKAN VIEW ¥ intent, DL —NRIRIXA AH URL

52 B XK EZM—AKN IntentFilter. 24 intent % B SR FF5, intent filter
FTH5R —AM&3h (i3 BroadcastReceiver, & F 1) AEMSIR/EMLE intent. —
ANES AR B BoR— N NECR T, T E A —A IntentFilter, XA
IntentFilter Z2H1TE B4 24 VIEW S EMFR R — 1 AR URI.  IntentFilter 75
Bi4E AndroidManifest.xml F15E X .

I RN # R intent, A—NBFFE DI B 5 — AN bR R AR T 0 o S A ET SR

Wk startActivity (myIntent) Jiik. R)a, RESTEITH %A

N HFR T E ) IntentFilter 2T 48, FBIHILE myIntent [ Intent X 1
Bl HHNEENCE] myintent FEENG, JFGEAT. 4 start i&3h 7758
fil & fEEAT myintent FIBH1E, XAMHLHIFR AL T A SSHETAL

o WHENEENS A M E A UL Intent IR R R —AME R

o EBNA] LAFEAR I  — N FAT AR IntentFilter 15T E 3 HUAR

| RRE A

YR AT LLfg ] BroadcastReceiver kR N FH Xt — AN S0 F 4l g . Bl
e HEFENR, RS e, BiE 3] T L. BroadcastReceivers
AReeEx UL, ©HA8E T NotificationManager K38 01 P X Be 48R 0 315 &
- 7 . BroadcastReceivers Bt ] LL7E AndroidManifest.xml HHyE M, 0] PLZEAR
R f§ ] context .registerReceiver () HATIHEM . (HIX LA BRI H 15 K E
I, VRN FAS 65175 3K 3 F BroadcastReceivers, £ 452> 1F 5 2 N B 5
PRI, FRAE L BLE LS fili % BroadcastReceivers. #Ff s F i a] DL i

H] Context.sendBroadcast () #'Ef1H W intent broadcasts | #%5 HE

R

J% 55

AN RSS A BAT - BURK AR i B EL AT P ST R o BB K — ANl
7 AN IEAE INFRTBCE 2 F 3k 0 ol (K AR SR T o A2 — N IARRR SRS IO N o
REZ A 2 AN, LA AT AR R R R e . 2R, AR E XA
THRETF AT X RL NGB, ROUAE & 2R 2 A9 S B 8 o e N 5 SR N 1% 3
FERRI o AT, AR BER XA s s 2
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http://code.google.com/android/reference/android/content/IntentFilter.html
http://code.google.com/android/reference/android/app/活动.html#start活动(android.content.Intent)
http://code.google.com/android/reference/android/content/BroadcastReceiver.html
http://code.google.com/android/reference/android/app/NotificationManager.html
http://code.google.com/android/reference/android/content/Context.html#registerReceiver(android.content.BroadcastReceiver, android.content.IntentFilter)
http://code.google.com/android/reference/android/content/Context.html#sendBroadcast(android.content.Intent)
http://code.google.com/android/reference/android/app/Service.html
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Context.startService () KEN—MRS, MIIATULEG &R FFE RO
B AN, RGO OREFX MRS — EHIMAT, EHEIXAS service ifT45 . (77T
PLiE L 3 Life Cycle of an Android Application FKEUE £ ¢ T RS HIN4). 5
A, BADERLLUENFH Context .bindService () ¥, EHEF— DRSS
b RN RS EERFBITKRNE) « JEER—NRE )G, BA1ER] LA
RS PR A N 5 S AT I . EBAARR AR XA kU, RATIE T DL
ITEE . EFEEEAE.

W AR

N RE B 5 B A T B LR A7 B0 . SQLite Fidis &, & AT A 2
BT UURARREUR B B B 5 e N L, AR RS IRE .
— NSRRI T — HARAERI 7V, NI RERS LE e 1 B PR AT B Bt
N AR LIS A B S PR 2R A . HE TR N R IR AR BT RE, AT A 3L
B4 Accessing Content Providers.

#HE: —MEeFANHAERES

AHREE T FHEFHARE T 30, VHEA TR Android HEZEAITE 2 T HE V. H O
HIFHLN o A— DTS EC B 4 TR ITAR, 1280l — A ] SaC A N
MREFE S BRI RO, IR DL IR VR 7, fe SRy #5dt TR 24
ZINHIZH AL UL, T2 35T R A9 B LB AT I AT RE P 555

SRR XM FAN AT RS A E— A (), &g
THRA K VAT LIS B IR e AN R 21 B IR, B D AL T 583 B QN
REFY o XSRS HR At 1 ARSI N B 7 (1 ——4R 26— 2B R I —— B ARV 414
fh o

ARGE LR e, — S EA SEPRIIRER Android MU AAIR T EHEAE 1, JF H
PR3 Android B A HR 1 — S8 AR O BB A SE IR Z A B - 25 128
DNRIZA a7 BRI TE S A L FH S I B 22 R T RE I, ART LA 55— 5 sUse BLE
FHARE P LRI 2524085,  BARWT 2% Sample Code SCASHR) .

A HE R EE

ZHRE L ERE A A —E4ak, JTHARLEHE—E Java Fifeis 5 MR
Fo WRARZATNRTG A Java MR FIITE, 5T CME L #ERE, H2%
S BEFERARNE R T .
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http://code.google.com/android/reference/android/content/Context.html#startService(android.content.Intent)
http://code.google.com/android/intro/lifecycle.html
http://code.google.com/android/reference/android/content/Context.html#bindService(android.content.Intent, android.content.ServiceConnection, int)
http://code.google.com/android/devel/data/contentproviders.html
http://www.chinaup.org/docs/samples/NotePad/index.html
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KHFENR O T — LB A1) Android B FHRE & FIARE o ARG LeIA A
fig AEEHIG, /R15Kr Overview of an Android Application #f4fiEik—T, A B
ARaL N .

R e 75 9 R I, IR IR AT R PR 8E & Pl Android $61F [ Eclipse. W%
RAH Eclipse, A5 AI5 R THX Le 25 S) RIS N AEAR i B A AN TR —
L35 K Eclipse K5 B AEAE Eclipse IDE H ] SEH ) a)

25 I TR HE

AR UEHRE I S8 Android MR T TAEAH (S B O 7E Installing the
SDK A1 Hello Android X P43 SCESFP it 1 FEAH U B o 3K 9 40 SR T4 e 17
NEEST Android BIFH, #5E H QR RIRERT LR EIR . IR % ) A2
ZHT, P SCRY . SDK 223 LR IT KBRS RS 0 OR AT 0 4%, RROR
KT
AT T 4 TAE:  project exercises archive (.zip) 2.ff 5 £ /KA
fH—H&F 3.37FF NotepadCodeLab 143

1. F# project exercises archive (.zip)

2. fRIEZIRAHE—HRT

3. 3TJF NotepadCodelLab {43
NotepadCodeLab iX— (3 FHAANATEM, BAk5772: Notepadvl,
Notepadv2, Notepadv3, NotepadvlSolution, Notepadv2Solution #
Notepadv3Solution. H:71i#% 11 Notepadv# it THE H RN ST E A, 1M
Notepadv#Solution M & X N Z % o« Gn RARFERE—Z5 2] rhad 2 je) @, R DL
IR A HE TR RS 5 0 B 2 ZE0T EE— TR ok B IRARE

2

PRI T AZREN R, IR G PR T NG AR . %k
S HRREHE TR B 5E B BT AT —ZR ST — T He R T

%1 — MRS AN R T A ARG T k. M — TR
IIETEEE, (HAN eS8 (1 Tl L AE 53R . R ListActivity 1)
FEAR T DA K e 60 e AN SR B0, RA R AR AT A — 4> SQLite
B AR

gﬁ
M
N

L AR R FERINGE A Activity. 7N Q04 K 3d — 37
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http://www.chinaup.org/docs/intro/anatomy.html
http://www.chinaup.org/docs/intro/installing.html
http://www.chinaup.org/docs/intro/installing.html
http://www.chinaup.org/docs/intro/hello-android.html
http://www.chinaup.org/docs/intro/codelab/NotepadCodeLab.zip
http://www.chinaup.org/docs/intro/tutorial-ex1.html
http://www.chinaup.org/docs/intro/tutorial-ex2.html
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Activity & Android #:1E R5t, TEAE Activity 2 [AIfEHIEE
SR 2 SR R, IR e 8
startActivityForResult()ix 4> AP | S E0E 55— 5 11 3% [\ — 4>

2R,
23 3 RN R RS st Event A= ay B #AR 4], LLAS 3 N AR AR
A iy B RS o
A2 R E H Eclipse RS M@ L K28 & A Event P4
Ja IRy . s AR e, (B I HERE— TR
HeRwIRREEES]
o XIARFIEARY LB —BERE R HIMSTE S Common Android
Tasks.

o Android SDK O Vidait—25% 2], Difese B feyus]. JAARiEs)
AICATEAR T #1) SDK 1) samples H 4 3],

o REARHIEE SDK samples Hk FHIsEBICFHAN HEFFFAEE S —
B, AHIERMIG T I, RS SRR, s A A ARG 4H i BE SDK
Sample H3& FRCFHANHRET . HAaE 7 —®iz NN N HE
7 HONAE BRI IS S, .

o EN—AMHFLINHE LEETER

o BIE—ANHEXWEREXARBE L, ZEHES daw() 7%,

EHERRGE —NHEIENA FRILHEZCEA

o  ContentProvider() /7% K —A 52 # 528

o WUHABGE IR ERAE AR B S R g B R E I 4 R
FRTA
Android SDK 04 % Fh &+ 1) € il T8, 7] LAF B R 7E Android “F & &30
NP . Horpig B8R T H 2 Android #4828 F1 Eclipse 1) Android FF & T &
it (2 SDK AL 17 & MaEsms EH TR, ek TA

Android ##).8% (Android Emulator )
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http://www.chinaup.org/docs/intro/tutorial-ex3.html
http://www.chinaup.org/docs/intro/tutorial-extra-credit.html
http://www.chinaup.org/docs/kb/commontasks.html
http://www.chinaup.org/docs/kb/commontasks.html
http://www.chinaup.org/docs/reference/emulator.html
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BRI TR RIS AT B — A SRR B B % o VR AT LA PR A8 RAE — A2 B
) Android JZ AT A5 N Bt NI R B R R R o

BEHMEZEE (Hierarchy Viewer new: )

JZ R MR g T B R VPR IR ARG P Ji i . e F AT AL 5 iR R AR B
(view) 147 J& 2 R BB R, BEAME LS Mar At 7 — A2 B = M (grid)
MR BE S48, IXFEREEAT LI AR J T o

Draw 9-patch new:!
Draw 9-patch T H o VAR BT WEIFTTS (WYSIWYG) 12 45 #% 52 Fa Hh Gl 7
NinePatch . ‘B A AT it fr i i EE, mremns N A X,

Eclipse IDE Android F & T B4 (Android Development Tools Plugin
for the Eclipse IDE)
ADT #fiff K RY & T Eclipse S I IIRE, {154 AR 1) Android N
FER R 5 SOGRH . in BARAE ] Eclipse, ADT i af LLEARAE DL B AS H i BT
& Android R F I JHFE .
o JRWTLLM Eclipse IDE #5517 & Android JF & T.H.. #iln, ADT A] LA
LR E 4 Eclipse Vi1l DDMS T HMIR 2 Diie—Brw A &, & Bl 1 %%
& (port-forwarding) % B Wr s, WMELREMPERE R
o ERMT—ASHIH S (New Project Wizard) , 5 BI/R PRI AE Bl il
gL Android B R T BT R B SR AR SO
o EfHFFHIE Android B FHREF SRR AR AR B Bk LA TR AT .
o ERRMET —/ android fASgwEESS, W] LAHEE BIR A Android manifest %%
TS 9 5 2K XML
Ak ADT #hifFI3E Z 1R B, G %3445 4, 7] 2% Installing the ADT Plugin
for Eclipse. WIARARIEE — ALK I FEHERE, 7/ 2% Hello Android.

Dalvik iR M28 8RS (Dalvik Debug Monitor Service (ddms))
XA T HEMR T Davik Ch Android “F& @ HilFBIML (VM) ), BEBSLLRTE
Bl 28 B 15 & A PR W B Rl AR A] DM F & R A0 RS, B E
AR, P PR MR, VB (heap) FIZRR(SE, AREURILZES
HI R, A B2 IR

Android #§iX# (Android Debug Bridge (adb) )
Adb T HAT CLLE R AR R & sl 2 b 2228 N IR 7 1) .apk S, I i AT 1
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http://www.chinaup.org/docs/reference/hierarchy-viewer.html
http://www.chinaup.org/docs/reference/draw9patch.html
http://www.chinaup.org/docs/reference/android/graphics/NinePatch.html
http://www.chinaup.org/docs/intro/installing.html#installingplugin
http://www.chinaup.org/docs/intro/installing.html#installingplugin
http://www.chinaup.org/docs/intro/installing.html#installingplugin
http://www.chinaup.org/docs/intro/hello-android.html
http://www.chinaup.org/docs/reference/ddms.html
http://www.chinaup.org/docs/reference/adb.html

Guangzhou University LEREEWY)

[ AP 28 BB 4 o At AT DA B4 Android BEADL88 B 45 b 1A N AR 7 ARAS Fl—
AR A R A E AR

Android Asset Packaging Tool (aapt)
Aapt T H A PLiEAR ) A5 Android SIS i — 3k il SO A0 B P S A .apk 3C
.

Android # O # & 1ES (Android Interface Description Language (aidl))
AT PR AR A R 1] 82 VAR, 1% 40 service BT REfSTFH L 11,

sqlite3
XA T HREW LR 7 H 7 0] SQLite £ AT o IX LB S22 tH Android [
FHAE 7B AT R 1

Traceview
AN T B AT CEAR) Android 2FFE 7 =2 R ER H & (trace log) #4659 ETE
HI 2 B E

mksdcard
ARG AL S (diskimage) , PRTT DAFERLIL A IR BE T 46 FH W A A5 R AR
AN (B SD £)

dx
Dx gongju #.class 7¥it% (bytecode) ##4 Android 7 it5 (fRAF1E.dex X
(ELLD)

Ul/Application Exerciser Monkey

Monkey @ ERI AR & BIZAT I — AN/ MR, EReNs AENRENLETH P 3
AL, Bl fSdi(click), fili#itouch), #%F (gestures) , H —RINIMNRFAH
HHA . URAT LU Monkey SRZG AR IEAE T & AR (S BENLIR), (H AT 221 77 I
K.

activitycreator
—ANAT L AE Ant build SO BEIAS, /] DS B & 2w ik 1 and roid B2 #2777
WRIRIESE Eclipse Bk, FHAEH ADT #d@tE, ARAS U XA IA
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http://www.chinaup.org/docs/reference/aapt.html
http://www.chinaup.org/docs/reference/aidl.html
http://www.chinaup.org/docs/reference/adb.html#sqlite
http://www.chinaup.org/docs/reference/traceview.html
http://www.chinaup.org/docs/reference/othertools.html#mksdcard
http://www.chinaup.org/docs/reference/othertools.html#dx
http://www.chinaup.org/docs/reference/monkey.html
http://www.chinaup.org/docs/reference/othertools.html#activitycreator

Guangzhou University LEREEWY)

Android MRS M, £5%, #HiE,
METE

FERZHERAE RS R, fEEMSL—A 15 1 a7 3CF Cin Windows B[
exe M), BRI LA AERERE, F RE A S H EIAR L S H #E4T H P A2 B {2 7E Android
B, XA R, BEARRIX L 5 o e AT A R R B .

1+ Android X Ff ] R 35 AR @ 1, 75 LI — AR AN [F) 35870 B R 75 22 2 AR — e
G N

« —/NMandroid & (WFx .apk) , HLEHE SR HAREF RS DL BE . X
BN EA, RN EI AT & LS.

o —MNAES  WEHASRYE NN NHAET RS @R
B—AERRAT LR EEESS, Xe— N LB, v LR ARIES D)4
FIHT &K,

o — HE B—MEENMRIEETR NI OHTE. W apk G ETA
RAGIBATE— /MR R, — R T— A apk &; A, 2HEE PR
RS ISISAT AL E, PR AP .apk 1 s MK iE5),
ks, s, BiE RRALEEAE.

H%

ORI — 5 Y EINA, Tebr 2T iy, eH#eE— Mt
%o WRAIRMAGE T —LyE 3 R A8 — 1 apk B, HbEH—4tEaeEe L EAND
GEILENED intent-filter L% 432

android.intent.category.LAUNCHER) , AE/RI.apk GaitlaE 7 —

BMAT S, TERARE SN TG S A2 A 1R AMESS 1 — 553

—AMES, WEFEFIM S, e — NN HFEF; MR ERIE, EREEE)
FAESH—NEE 2 ME, BFE - Esik. YiRE

Intent. FLAG ACTIVITY NEW TASK #3883 — AN iEsh & B, AT mgi e
T EANEE AR E, & XX EANMES . a8 5 3 A X
PRI IZATIE R —MESS B (BRAEIRITE ) AR R A 5 3, XA RS
gD o WERURME FLAG_ACTMITY_NEW_TASK #ric I Hix AN & KIAESS
CAE3N, AE5KRE )3 B HT & 1A 2 BRI
FLAG_ACTNVITY_NEW_TASK % ZUNMER : fEH 7 E R, —AS# N AT
HUEE 2. WRIXARRIAE R, RAEEAE NS . 54, WRAF
L S THI AR H 3 b Ji R (1) b 75 4R 5 A RS 1 = AT — AN AT 5%, AR 75 e
FB AL FRid. S, i P ERRE sh T2 B % S (HOME) %, i
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http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestApplication_process
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestApplication
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestActivity
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestReceiver
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestService
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestProvider
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestIntentFilter
http://www.chinaup.org/docs/reference/android/content/Intent.html#FLAG_ACTIVITY_NEW_TASK
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AFEIRH (BACK) #, RAAEST LA RAT 55 (R3S SR e s A Py R i, 3%
A INERIIHE %

fE%35M/17 (Affinities)

—LEIE LR Android 75 RN RANME 55 S BB E T — NMRERR AT 55, RIEZAT:
BIEBA R BN XBIIAEFS LM IR, ENES AT R i T
GBSt — M — L = ERS A 7. BRANIES a4 AR S Se  4 5, k
R TLIZIE B .apk 44 . KR — Ml R, XS R, A 7E.apk
£ S Bh#R S B — N ) — &8

LARH Intent.FLAG ACTIVITY NEW TASK #ridBsh— ANEiEsh, 155355
RSB S S iE s A e : e —HIBITEE B/ MES B . 2R
1M, WA NEW_TASK t3id, SEM il A RAES & 1 A M F T
FA 1. WRE, ZEFSHEUIREATG, S SEAES R B E 30,
PRT AFEAR I 2R 30 SC A L 1) S AR P AR 28 3L apk LB B & 3 EAR E O

TS5 SE RN JT, ARAT DI BB RS B 1 AR 2 o 1K HLA 4] -V 7 qe] {8 1

o WMEARM.apk BEAEZAH A ESH EENHER, AR feAE
BRGNS IEARIRSEMN Ty X BE —DAERPE, R LEA R
(4 778 B8 S nfE.apk B4 7)1 . flim,
"com.android.contacts" )55 Al 774y % 1T DL
"com.android.contacts:Dialer" and
"com.android.contacts:ContactsList" .

o INFRVRAEE AN @A, PG, B SRR NSNS S Bl SRR R A
BN, ARTEEAEARAR S H 1 Bl L B ) v BT 55 S N U7 (taskAffinity) . 71,
WRARAR S H B R VRGNS B Y S CH P AT DL B A B il it ety X
D, R EAE B T 5555 7 (taskAffinity) v “com.android.contacts”

JB SRR LR S5m0

(i R 0 O 53015 5 S 7 VA e 5 L B R R 4 LA A A
FEHIBRIL . PSS ML DR IR L 2R3 R BB B 3 A
SCRELATHIE . 3 BT R — L3 F I R B T LR AR R L 275 2

TR A A AZ singleTop (B T BUAN standard B30 o XA
557 A A5 s AU BT IEAERR T2 (R B[R] — NG 3 o

singleTask BAXESA LM & REMASIN 3 SR B IS5 BT T
(H ¥ CEFT IS VI EIRT 62K o A XM TR 2N /N0 iz ke 2
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http://www.chinaup.org/docs/reference/android/content/Intent.html#FLAG_ACTIVITY_NEW_TASK
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestApplication
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestActivity_launchMode
http://www.chinaup.org/docs/reference/android/content/Intent.html#setFlags(int)
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WA R R G AR A2 B, B R BESZI AT A TS 80 o X A B 0 - 2
RN ESIIRRCT . (GZHE MAIN 353581 LAUNCHER 4335%) &

singleInstance JAZIRUEIRIIR, ZA A e HRA N R — Mg shint

fSTH

H—MENARSLEIED, e (nEREHLS SearchManager 5% @
HEHEAS NotificationManager) <8 siRES . XMIFM T, 1RFEEEH
Intent.FLAG ACTIVITY NEW TASK #rid, BUNIEENIEALS GXASMHNES
WEEBIES) MG . R RIRIA R —FE, XU bR AR R
YT AT 55 RT3 2 RS A MR DT BE AT 55 2= VI BIHT & 5 985 15 % Ui 3 21
—ANHEIES . 28R, VR LS e 2R A R

— AN BIEOE R R ¥ Intent. FLAG_ACTIVITY CLEAR TOP 1 NEW_TASK
— A XA, WEIRIREIES B T 8179, SR EIE 62k, £
BB A ESI R TRGES), #HEAE S, MIESIH onNewintent(Intent) 77

FAEANBESEUREOE M . S TEX A5 E singleTop B

singleTask BAMRALF P, ZFELATRPISBEN—DBHEE, M

AN B S S AT 2588 05 A B — AN S

S AMRTT LIS B () — AN 5 iR B B IS S RS s A S i (RN 2R
71, RJfa & E finishOnBackground J& . a5 ARAELEH 45 R FE fH— AN B
(V& BN I rad A, B R BB R AE S B, XA A . B e ANE
PE, ANEH A H BACK i /& HOME, JEsh#li & 45 tnRIX AN @ M H 18 5
% HOME ##44 2 S80S S AT SR BE RS B, B A IEIR [F BT 5%
B,

TR AR B B SRS 8 i B % JaunchMode attribute)  BA K & &brid (ntent
flags) , FCVEREEIEIAIHELIE S .

pri
£ Android ™, BEREE N FHFEFF A SERESEIL, AR P T RRRIREE . AT
T IRIR fa] 5.
o RmERREEM e, BAMEEEGE A AR sh B A BERE .
o ALK A .apk WIEATLE R AR B> RGUT
o TN ARGUE BB, R E ARSI N AR AR B, XA AT DL
R S5 N FH A e ) LA B 20
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http://www.chinaup.org/docs/reference/android/app/SearchManager.html
http://www.chinaup.org/docs/reference/android/app/NotificationManager.html
http://www.chinaup.org/docs/reference/android/content/Intent.html#FLAG_ACTIVITY_NEW_TASK
http://www.chinaup.org/docs/reference/android/content/Intent.html#FLAG_ACTIVITY_CLEAR_TOP
http://www.chinaup.org/docs/reference/android/app/Activity.html#onNewIntent(android.content.Intent)
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestActivity_finishOnTaskLaunch
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestActivity_launchMode
http://www.chinaup.org/docs/reference/android/content/Intent.html#setFlags(int)
http://www.chinaup.org/docs/reference/android/content/Intent.html#setFlags(int)

Guangzhou University LEREEWY)

R AT IR R A, BEAE (1 & PR IR A L AT Rk N AL s AT I HERE » 7
ERANEEARE R ZG L e RN apk AR ZEE—MH ) D, Ak
FlsAT el — D EEREE, IXFPE IR A VRR), S ER GBI DANF
IEERE o

BB LA RSO AR IUE 2 5622 4= IR 5 T (15 /8

ZiFE

BAMERAET NS ANERE, 28BN T, Android ER7EHFE RO 2RI
T, BRAEEOIEE HOMERE, RAISIREEN AT R, — A HEE
2 Te A BT WU s, s, DA R RS IR SEBIER A2 Hx AN kR L ig

AT RO

RO R FEAR NG, | FElEs, RS H N A FRAEER LB A . X e
FAFE P (O 2R A0 R B S Ab (BRIAE A Ui, ER7E R — N REab s , SR
R E R X UL Y RS X e CFEIRSS) AN R
B aE HBERAE OIAZ M ZIP I s TH G , RO B AR ) i 3L
T2 o AR AT DU P AR v R RS 2883 Android 1) HandlerThread 282:%1 He
RFEPATITFRRRAE

X A S T A LR A (1451 b«

o Y IBinder 353 IBinder SEELAIHE T, WnHIZ Ik 5 HABBERE, fRAT
DL T 2R AR K% IBinder Bk A B RE A R FE UL I AT, AHERE )
FLRFENP IR AT LA o FRERTE LT, P — N IR4S (1 Binder AT LUIXFE
AOFR . CERSRAE RS BRI A R AR O R 5E . ) IXE MRS IBinder
B D SE B AT — R R FE 22 A 10590, IXFEAE R 2R AR A e [R5 il
B

o PRI IEFEMEF LR RE Sk 3 2672 DL IBinder JRAE A 52 E2% 1)
F k. PRI EE AR PR R R B L. XK LI IX Ty
R EA — PR A RS, XA R L e R AR R AT DAy e

o PRRYRLIE LR AL L AR IS AT R FR A R 2. JBHE BT, X2
TE R EL6FE, WMARAREIE — MR E R —NE O, AR E
FIRE LK AR 2652 B 31

Android N &R Ay B3

TERZHIEN T, &4 Android N HFEFFERIEATAE B &/ Linux #ERE A . 248 H
FE P B AR 5 BLS AT, XA A I — HigiT T &, HIRGUAN
I REANEA N IE . ARG R G0 RIUSCHERE (5 F A0 A7 DUE o lic 25 Hee i B R
Ko
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http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestApplication_process
http://www.chinaup.org/docs/devel/security.html
http://www.chinaup.org/docs/reference/android/app/Activity.html
http://www.chinaup.org/docs/reference/android/content/BroadcastReceiver.html
http://www.chinaup.org/docs/reference/android/app/Service.html
http://www.chinaup.org/docs/reference/java/lang/Thread.html
http://www.chinaup.org/docs/reference/android/os/HandlerThread.html
http://www.chinaup.org/docs/reference/android/os/IBinder.html
http://www.chinaup.org/docs/reference/android/app/Service.html
http://www.chinaup.org/docs/reference/android/content/ContentProvider.html
http://www.chinaup.org/docs/reference/android/view/View.html

Guangzhou University LEREEWY)

IR P B N B0 2B g AN TR 1) B FH AR e A OJCH 2 Activity, Service, Al
BroadcastReceiver) & Wil 520 B A 2 7t AR ARy A ), X R IR E B —
. PEFHHEARXEHATTRESBRERCEEPTEEESHNARE
ain
— N LR R A o B bug 57 & BroadcastReceiver, 4
BroadcastReceiver 7£ BroadcastReceiver.onReceive () /7% 45U F]—4 Intent
B, BRI — MR, REiRkE. —HERF, 2506108 BroadcastReceiver
AEATIESRA, I BroadcastReceiver Frfe KR A A H T (BIE
R IEE e AR TSRS - Ktk RGeS TR ZI A A0
FE AR N AT o IXAES 16, BRI (spawned) Hi ISR AR OB 28 1
SeFIX A 0] ) i v 5 5 42 ML BroadcastReceiver JE 31— MRS, 1k 5 GikniE gk
R A TiE SRS TAE . AT REENIEAN R 1L RG R I ERE,
Android FRHfE &SRR I AT I 2 A DL A A IR S TR R N — AN B B 4y
Z% (importance hierarchy)’#1. IR GREEREHT)
1. Aie (foreground) ##2, S5H ) 4uiEEMMEHEEVIAHI. ANET
N R PP 2l A e g ik AN R 7 VA e i fE B RERE RIET & o 2 T R
— AN R, AT ULE R AER R 6

1. HRRIEERRN RTINS IT — NS P 2R Activity  CEF)
onResume() /5 1245 i D
2. 3 —IEAEIET ) BroadcastReceiver (‘e )
BroadcastReceiver.onReceive() /7 % IEEHAT)
3. A Senvice, Ff HTE Service 1A E1H b5 %
(Service.onCreate(), Service.onStart(), 8¢ Service.onDestroy())
WA IEAESAT AR
1. ®J0L Cvisible) #EFE, ©A— A L H P B B 21 Activity, {H
AERT S CEN onPause()VH¥EH A o 28BSk UL, W5 HT & 1 Activity
Je—/NOUEHE, DLHTIY Activity BRUEEXRTEHEZ 5, Binl B H BLX Fh 2 .
PR AR, —RANRVFBRIE, BRIEN T ORIERT & R s 1T
AFAIE R
2. % (service) #tfE, H— B4 M startService() 77755 s Service.
BANX AR PGV E E R 2, B e FHEH 2 P oSG ()
11[1}:‘* MP3 [l e G & M EHRN A THD « Bk, RS0 —HIiB T
XL GEFEFR AR N AEAS & DAZERR A B HT & 2ERE A ] Wi fE o
. Ja& (background) 1&%} WE—A 400 H P EARIR Activity CE R
onStogQﬁ‘?ﬂE’d)ﬁﬁH) TR R P ARG A BRI R . SR AT
IEFRHAT T Activity A2 dr il (FE4E(E B 0T 2% Activity) , REATUEEE
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http://code.google.com/android/reference/android/app/Activity.html
http://code.google.com/android/reference/android/app/Service.html
http://code.google.com/android/reference/android/content/BroadcastReceiver.html
http://code.google.com/android/reference/android/content/BroadcastReceiver.html
http://code.google.com/android/reference/android/content/BroadcastReceiver.html
http://code.google.com/android/reference/android/content/BroadcastReceiver.html#onReceive(android.content.Context, android.content.Intent)
http://code.google.com/android/reference/android/app/Activity.html
http://code.google.com/android/reference/android/app/Activity.html#onResume()
http://code.google.com/android/reference/android/content/BroadcastReceiver.html
http://code.google.com/android/reference/android/content/BroadcastReceiver.html#onReceive(android.content.Context, android.content.Intent)
http://code.google.com/android/reference/android/app/Service.html
http://code.google.com/android/reference/android/app/Service.html
http://code.google.com/android/reference/android/app/Service.html#onCreate()
http://code.google.com/android/reference/android/app/Service.html#onStart(android.content.Intent, int)
http://code.google.com/android/reference/android/app/Service.html#onDestroy()
http://code.google.com/android/reference/android/app/Activity.html
http://code.google.com/android/reference/android/app/Activity.html#onPause()
http://code.google.com/android/reference/android/content/Context.html#startService(android.content.Intent)
http://code.google.com/android/reference/android/app/Service.html
http://code.google.com/android/reference/android/app/Activity.html
http://code.google.com/android/reference/android/app/Activity.html#onStop()
http://code.google.com/android/reference/android/app/Activity.html

Guangzhou University LEREEWY)

I 2RI R R W N AE, FRPRpLE mr i = MR it AR . RacdidE
HHRZANXFEFRTEZT, B ER X g R R A7 7E LRU ZIK
PABAR 4 N AEAS R i P Bl B B R i Je — Ml R 3
4. 7 (empty) R, NOEALMETIESIRS WS HRRF A, R XF
HRRHIME— R R, T RN R A A & E s T, AR EEN
QUEEGERE, IXFERTCASE = e B .
R GUR DR P AL T 15 S R AS 2L ) R N B i AR AT 0 2K 16 2
2 Activity, Service A BroadcastReceiver SRR R4 <X Lo 2H 4 1F HEFE &
AR iy B RO G0 F I VEARME S o B N ERE SR B SCRS R IR T e A2 R
T R . FH R A A o JE ) o B2 (R A S 2 mT et R 1l 5 FL e gk A
fofasioC RMIG . flan, Wi A @SR B HikE
Context.BIND AUTO CREATE #ricd8f#H ContentProvider # 4% & 2| — /™ ilk
% (Serice) , HAREFE B fE5r 2K 2 /DB E R SR A R4 E

. FRMHARER

Implementing a User Interface

This section describes the basics of how to implement the user interface of an

Android screen. It covers the basic elements that make up a screen, how to
define a screen in XML and load itin your code, and various other tasks you'll
need to handle for your user interface.

Topics

o Hierarchy of Screen Elements

« Common Layout Objects

« Working with AdapterViews (Binding to Data)

¢ Designing Your Screen in XML

« Hooking into a Screen Element

e Listening for Ul Notifications

« Applying a Theme to Your Application

« Ul Elements and Concepts Glossary

Android N FH 4 Jk
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http://code.google.com/android/reference/android/app/Activity.html
http://code.google.com/android/reference/android/app/Service.html
http://code.google.com/android/reference/android/content/BroadcastReceiver.html
http://code.google.com/android/reference/android/content/Context.html#BIND_AUTO_CREATE
http://code.google.com/android/reference/android/content/ContentProvider.html
http://code.google.com/android/reference/android/app/Service.html
http://www.chinaup.org/docs/devel/ui/hierarchy.html
http://www.chinaup.org/docs/devel/ui/layout.html
http://www.chinaup.org/docs/devel/ui/binding.html
http://www.chinaup.org/docs/devel/ui/xml.html
http://www.chinaup.org/docs/devel/ui/hooking.html
http://www.chinaup.org/docs/devel/ui/notifications.html
http://www.chinaup.org/docs/devel/ui/applying-themes.html
http://www.chinaup.org/docs/devel/ui/glossary.html

Guangzhou University LEREEWY)

Android B FH /2 HH & Rl &AL R LA R Rl IR B 20 A R 2 R P BIOEE F2 1Y
HERA BIULAR AT DAE EATTE BB E R — N R — N H

W, X AEITER A KRG AR B . FRE AT DATEIX /N RE LA g 2 A
R GXRRE KD , WRSEIRW ] DLEIEMSL it RE . A X Fpg it
FAEE /D WA, BN Android S gAY AR [A) 3 B .

DL B4 2 1R B ZL ) Android APIs:

AndroidManifest.xml

AndroidManifest.xml J& 245 48§ SCHF, & & F R G W] AL B AR By 61 4
FIFTE TZ 4400 H &2 activities, IR 55, Intent $2 5028 F1 5 TH b 7O Y 2
EHAR). 20 kU, FHISCH RS EAREES) (Activities) EHEIY
Intents & 7E— IR K”
&3l (Activities)

s (Activity) g —MEAEMEEAN %, —A Activity 52 58
Yo TAERACISE, Wb BTG, XE S TAES AT e HE Xt P Ul i
B R e AL IXA R BIN, HYiE I TR UL . A, 7R
W T8 e AR I N R T A B — NS S AR PN E i

ME (Views)

M (Views) ] LUK B 280 2] 5E % L. Android B - S 1H B — R 5
PIFLER  (trees of views) M. 2 # B —2H DA 19 7 =X H TR

PR R o HF 3 ] DA B g — A8 A B 1 vk F B e )
B AL B H AR (PL i & Rk, sl e A T A I P IR UNE D
F 1 (widget)).

Intents

Intents & — AR IEEXN R, ERREFEMIEER R E
(intention) o bt anan SEARE N FHFE A B R R — AN T R4 e s I 61
@ Intent 21 K HAL S RGREREERIEXA URL. 250K
SE LT R0IE AT REAC R IX — Intent FUARES (FE 2 BUTEOL R a2l i as),
FEBITZ . Intents tHA] LA T 4% R G096 N AOA 2034 () s n =R
).

k% (Services)
MR 45 R s T e — B, ‘e LLUSITEE 3 R i aT LUs 4Ty
EHARRN AR RN BN (context) B, IXEUT H S1K 7 E.,
He A gsE s — AR %5 (Sewice) L, @@ 2
(RPC) RiHHIXA Tk Bl misas ks, AR H Gk
BEEEH 7 S, WA SR A B SRR OR T DAAR SRR T, X AR R SS
(service) SKARIE S F ;- FETH OC P I 5 5K 4k S 3R T30

B4 (Notifications)
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http://www.chinaup.org/docs/devel/bblocks-manifest.html
http://www.chinaup.org/docs/reference/android/app/Activity.html
http://www.chinaup.org/docs/reference/android/view/View.html
http://www.chinaup.org/docs/reference/android/content/Intent.html
http://www.chinaup.org/docs/reference/android/app/Service.html
http://www.chinaup.org/docs/reference/android/app/NotificationManager.html
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http://www.chinaup.org/docs/reference/android/content/ContentProvider.html
http://www.chinaup.org/docs/devel/data/preferences.html
http://www.chinaup.org/docs/devel/data/files.html
http://www.chinaup.org/docs/devel/data/databases.html
http://www.chinaup.org/docs/devel/data/contentproviders.html
http://www.chinaup.org/docs/devel/data/network.html
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http://www.chinaup.org/docs/devel/security.html#arch#arch
http://www.chinaup.org/docs/devel/security.html#signing#signing
http://www.chinaup.org/docs/devel/security.html#userid#userid
http://www.chinaup.org/docs/devel/security.html#permissions#permissions
http://www.chinaup.org/docs/devel/security.html#declaring#declaring
http://www.chinaup.org/docs/devel/security.html#manifest#manifest
http://www.chinaup.org/docs/devel/security.html#broadcasts#broadcasts
http://www.chinaup.org/docs/devel/security.html#enforcement#enforcement
http://www.chinaup.org/docs/devel/security.html#uri#uri
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http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifest
http://www.chinaup.org/docs/reference/android/R.attr.html#sharedUserId
http://www.chinaup.org/docs/reference/android/content/Context.html#getSharedPreferences(java.lang.String, int)
http://www.chinaup.org/docs/reference/android/content/Context.html#openFileOutput(java.lang.String, int)
http://www.chinaup.org/docs/reference/android/content/Context.html#openOrCreateDatabase(java.lang.String, int, android.database.sqlite.SQLiteDatabase.CursorFactory)
http://www.chinaup.org/docs/reference/android/content/Context.html#MODE_WORLD_READABLE
http://www.chinaup.org/docs/reference/android/content/Context.html#MODE_WORLD_WRITEABLE
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestUsesPermission
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package="com.android.app.myapp" >

<uses-permission

android:name="android.permission.RECEIVE SMS" />

</manifest>
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http://www.chinaup.org/docs/reference/android/content/Context.html#sendBroadcast(android.content.Intent)
http://www.chinaup.org/docs/reference/java/lang/SecurityException.html
http://www.chinaup.org/docs/reference/android/Manifest.permission.html
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestPermission
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<manifest

xmlns:android="http://schemas.android.com/apk/res/android

package="com.me.app.myapp" >

<permission

android:name="com.me.app.myapp.permission.DEADLY ACTIVITY

android:label="@string/permlab deadlyActivity"

android:description="@string/permdesc_deadlyActivity"

android:permissionGroup="android.permission-group.COST MO
NEY"

android:protectionLevel="dangerous" />

</manifest>

<protectionLevel> &4 & AT, FF RS0 H 7 B an{ar b 38 3N AR 7 42 21015 5K
A PR A a@ T, B LI AN SRS HR S IX AN RR IRV BT AR
<permissionGroup> J& M2 AT E K], A T RGOVH P BoRUR . Gl ,
R BIXEE, MR R4 4 (FI7E android.Manifest.permission group
D), BEEEZHREN FEAE L. EEmATEH—-ACEFERd, ey
A A PR P S B 25 FH -

R MiZNGENBIR IR AR (label) AR (description). 24 FH 7 il WAL PR 51

R, EATTLUSH P R FRF 88, W(android:label) BiE —MFAIHITE

if5 2 (android:description) . trn&(label)bbBsE, H LA RHR %

RR PRI R BE T RE . Fiiik (description) iz & — 4 01, TR SRAF PR 1
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http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestPermission_protectionLevel
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestPermission_permissionGroup
http://www.chinaup.org/docs/reference/android/Manifest.permission_group.html
http://www.chinaup.org/docs/reference/android/Manifest.permission_group.html
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestPermission_label
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestPermission_description

Guangzhou University LEREEWY)

H P U4« BRATE MR I BUE M a)uE, H—a) S AR, 28 a2 A
PSR AR, 2 KA AA iziﬁﬂﬁ%hao
N2 — CALL_PHONE #UBR AR R IR [ 51 1«

<string name="permlab callPhone">directly call phone
numbers</string>

<string name="permdesc callPhone">Allows the application

to call

phone numbers without your intervention. Malicious

applications may

cause unexpected calls on your phone bill. Note that

this does not

allow the application to call emergency

numbers.</string>

YRA] LAE R Geidid shell ff% adb shell pm list permissions BHF
PRUHTE Lo R, -t $5AF DU Sop g o7 O s A 2 B s AR

$ adb shell pm list permissions -s

All Permissions:

Network communication: view Wi-Fi state, create Bluetooth

connections, full

Internet access, view network state

Your location: access extra location provider commands, fine

(GPS) location,
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mock location sources for testing, coarse (network-based)
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Services that cost you money: send SMS messages, directlycall

phone numbers
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http://www.chinaup.org/docs/reference/android/R.attr.html#permission
http://www.chinaup.org/docs/reference/android/app/Activity.html
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestActivity
http://www.chinaup.org/docs/reference/android/app/Activity.html
http://www.chinaup.org/docs/reference/android/content/Context.html#startActivity(android.content.Intent)
http://www.chinaup.org/docs/reference/android/app/Activity.html#startActivityForResult(android.content.Intent, int)
http://www.chinaup.org/docs/reference/java/lang/SecurityException.html
http://www.chinaup.org/docs/reference/android/app/Service.html
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestService
http://www.chinaup.org/docs/reference/android/content/Context.html#startService(android.content.Intent)
http://www.chinaup.org/docs/reference/android/content/Context.html#stopService(android.content.Intent)
http://www.chinaup.org/docs/reference/android/content/Context.html#bindService(android.content.Intent, android.content.ServiceConnection, int)
http://www.chinaup.org/docs/reference/java/lang/SecurityException.html
http://www.chinaup.org/docs/reference/android/content/BroadcastReceiver.html
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestReceiver
http://www.chinaup.org/docs/reference/android/content/Context.html#sendBroadcast(android.content.Intent)
http://www.chinaup.org/docs/reference/android/content/Context.html#registerReceiver(android.content.BroadcastReceiver, android.content.IntentFilter, java.lang.String, android.os.Handler)
http://www.chinaup.org/docs/reference/android/content/Context.html#sendBroadcast(android.content.Intent, java.lang.String)
http://www.chinaup.org/docs/reference/android/content/ContentProvider.html
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestProvider
http://www.chinaup.org/docs/reference/android/content/ContentProvider.html
http://www.chinaup.org/docs/reference/android/R.attr.html#readPermission
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http://www.chinaup.org/docs/reference/android/R.attr.html#writePermission
http://www.chinaup.org/docs/reference/android/content/ContentResolver.html#query(android.net.Uri, java.lang.String[], java.lang.String, java.lang.String[], java.lang.String)
http://www.chinaup.org/docs/reference/android/content/ContentResolver.html#insert(android.net.Uri, android.content.ContentValues)
http://www.chinaup.org/docs/reference/android/content/ContentResolver.html#update(android.net.Uri, android.content.ContentValues, java.lang.String, java.lang.String[])
http://www.chinaup.org/docs/reference/android/content/ContentResolver.html#delete(android.net.Uri, java.lang.String, java.lang.String[])
http://www.chinaup.org/docs/reference/android/content/BroadcastReceiver.html
http://www.chinaup.org/docs/reference/android/content/Context.html#sendBroadcast(android.content.Intent, java.lang.String)
http://www.chinaup.org/docs/reference/android/content/Context.html#checkCallingPermission(java.lang.String)
http://www.chinaup.org/docs/reference/android/content/Context.html#checkPermission(java.lang.String, int, int)
http://www.chinaup.org/docs/reference/android/content/pm/PackageManager.html#checkPermission(java.lang.String, java.lang.String)
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http://www.chinaup.org/docs/reference/android/content/Intent.html#FLAG_GRANT_READ_URI_PERMISSION
http://www.chinaup.org/docs/reference/android/content/Intent.html#FLAG_GRANT_WRITE_URI_PERMISSION
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestProvider_grantUriPermissions
http://www.chinaup.org/docs/reference/android/R.styleable.html#AndroidManifestGrantUriPermission
http://www.chinaup.org/docs/reference/android/content/Context.html#grantUriPermission(java.lang.String, android.net.Uri, int)
http://www.chinaup.org/docs/reference/android/content/Context.html#revokeUriPermission(android.net.Uri, int)
http://www.chinaup.org/docs/reference/android/content/Context.html#checkUriPermission(android.net.Uri, int, int, int)
http://www.chinaup.org/docs/devel/resources-i18n.html#Resources#Resources
http://www.chinaup.org/docs/devel/resources-i18n.html#CreatingResources#CreatingResources
http://www.chinaup.org/docs/devel/resources-i18n.html#UsingResources#UsingResources
http://www.chinaup.org/docs/devel/resources-i18n.html#ResourcesInCode#ResourcesInCode
http://www.chinaup.org/docs/devel/resources-i18n.html#ReferencesToResources#ReferencesToResources
http://www.chinaup.org/docs/devel/resources-i18n.html#ReferencesToThemeAttributes#ReferencesToThemeAttributes
http://www.chinaup.org/docs/devel/resources-i18n.html#UsingSystemResources#UsingSystemResources
http://www.chinaup.org/docs/devel/resources-i18n.html#AlternateResources#AlternateResources
http://www.chinaup.org/docs/reference/available-resources.html
http://www.chinaup.org/docs/devel/resources-i18n.html#ResourcesTerminology#ResourcesTerminology
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http://www.chinaup.org/docs/devel/resources-i18n.html#i18n#i18n
http://www.chinaup.org/android/reference/available-resources.html
http://www.chinaup.org/docs/reference/available-resources.html
http://www.chinaup.org/docs/reference/android/content/res/Resources.html
http://www.chinaup.org/docs/reference/android/content/Context.html#getResources()
http://www.chinaup.org/docs/reference/available-resources.html
http://www.chinaup.org/docs/reference/available-resources.html#animationdrawable
http://www.chinaup.org/docs/reference/available-resources.html#tweenedanimation
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SEm R

res/drawable/

PNg, .9.png, jpg files XKLL [T L PR T Flik bt
I 2 ¥ A 2

N T AR LTI AR,
Resource.getDrawable (id)

o AL

o  9-patches (A8 RFHIEE)

res/layout/

I 9 PE RSB REAT SR ) XML SO (B BER 0 — 30 r). &
B Aikm

res/values/

R G B 8 2 i S R B YR A S A

HER: MEHAN res/ I, B REF YT AT B 1) S,
B R BB HAE AR TIEA S, XML o0 A
PLE XL B AE R.class BAT 4 B B

SO AT CAR A 4 ONARAT 44 7, SO AT — SR S R 0 S0 A
(ML SR BLoE e 3R B R 0 9 SCE 44D

o arrays.xml & XE4
colors.xml & X Gift N Gita 7 HUE. Ral LA

il Resources.getDrawable () PAK

Resources.getColor (), respectively, HX
o dimensxml & J-FHdE - HH

Resources.getDimension () HUfFXLEEHIR,
o strings.xml & X FRFH HE (ffFH
Resources.getString B

Resources.getText () HAFHEIE, (FEHEL—

B getText () BEECEILEF P A 1 BRI SCARKE
BECA,
styles.xml & M X4,
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http://www.chinaup.org/docs/devel/resources-i18n.html#colorvals#colorvals
http://www.chinaup.org/docs/reference/available-resources.html#dimension
http://www.chinaup.org/android/reference/available-resources.html#stylesandthemes
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res/xml/ fFA] XML SCH AT A T 9w P8, JERE(EIS T H
Resources.getXML() &7~ XML 5S04,

res/raw/ X AR SO AR R R R BB % B i i
REEHE A PG, ENTEZEMARRE PR, AT
FERE P A X LE BEE, AR AT LA

Resources.openRawResource() , A ID:

R.raw.somefilename.

PRI A 2 m PR APK SCHF,  Android B — MR, @& N R, IXFEAR
RE MR A ACRS BLAE AR SE B o ARG B R AR AN S 2 AR, RBEIRZ T

R EIRE
o  —UUEIER AR E XA . CREFER ZFINEISRIRE - VRO LB Y,
#RGB, #ARGB, #RRGGBB, #AARRGGBB iX#f 16 it E#5ay LA,
o FTEWEEAEA] LI E — AN RVHAE, IR EIPIAS 16 3E1 s 2 NiE W .
O 7EF /RIE(E LR BB . 245K, BRIMEZ B,

15 FH BHR
A S A A AR OURE MBI, L B
o ZEARFSEAERIVIR - TAEACR R R IR S
o MEABBERESIH - AT FAR SRS S, R AT LS A

o AFEWEMEHTARFI - 7T LEZIRALEE R A FTE 5 DL B AR A
[7l ) B o

Zw kIS, Android P#2E— AN R BI2E, BRI T A KI5 XNREE
R 7. & MHEEZ Android SCRFR, [N, a4 — DB

B SR B N 5 SR AIFR URAT, AR BLEARS TR o TR AN
BB, BEEE AR, ARt (s » BUAEERE

ER: XN REERAINTFLEN, RARETHHS. DR URERESBB)
B
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package com.android.samples;
public final class R {
public static final class string {
public static final int greeting=0x0204000¢;
public static final int start button text=0x02040001;

public static final int

submit button text=0x02040008;
public static final int main screen title=0x0204000a;
b
public static final class layout {
public static final int start screen=0x02070000;
public static final int new user pane=0x02070001;

public static final int select user 1ist=0x02070002;

}i

public static final class drawable {
public static final int company 1ogo=0x02020005;
public static final int smiling cat=0x02020006;

public static final int
yellow fade background=0x02020007;

public static final int stretch button 1=0x02020008;

b g
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TE ARG s A 2R

REZLRBEGHIRI 1D VLSRG 1 H AR ST K B PR S Al T AR ACAY BLE A e
Ko MifE LA

R.resource type.resource name

EEn

android.R.resource type.resource name

resource type f& R TR —FKA, resource name & XAE XML I
1 B BRI A4 B 9 Ho At SO 2R 5 SCRI BRI ST G Ja48) 4. BEFh SR TYY
BRSNS — MR ER R K73 O 72221000 R 728 A IR 1
PR, ZEREIIA SO . g Bk B R RE A B SRR AN 75 B 44 i e]
LB R 2] (RIXHE: R. resource type.resource name) .Android
LS —SehRE TR, WIBE AR, I R B A X LAY, IRREAE
android,m]android.R.drawable.button_background.

X LA B R ATURERE PR 57] U 3 A e A LA P 4 38 i 11 B -

/ /7 i B B RS B — A Wi R T R

this.getWindow () . setBackgroundDrawableResource (R.drawable

.my background image);

// BERD R —ABHR 1D BA A FEFA A RIET

this.getWindow () .setTitle (R.string.main title);

/ /IR 7GR 2 5 LA b A
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this.getWindow () .setTitle (Resources.getText (R.string.main
_title));

/1 I R R A R R

setContentView (R.layout.main screen);

//M ViewFlipper Xt % H ¥ & Bl —mi .

mFlipper.setInAnimation (AnimationUtils.loadAnimation (this

14

R.anim.hyperspace in)) ;

// 1E TextView X R HKE LANE.

TextView msgTextView = (TextView) findViewByID (R.id.msqg) ;

msgTextView.setText (R.string.hello message);

B’IRGIH

—ANEETE (BE B BLSRAEHHE n] AR SRR B KR U
FAEAT & SO A 55 B (AT DA AR S AE) DR IR (FRAE T Hefl SR i)
AL A 51 AT Do A A AN B BTy B YRR A

flan, WmRA SEGHE, BATH LU SORRIEEAE S EA4T R Sk, B e
P BEIR SCA BLERAS -

<?xml version="1.0" encoding="utf-8"?>

<EditText id="text"
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xmlns:android="http://schemas.android.com/apk/res/android

android:layout width="fill parent"
android:layout height="fill parent"

android:textColor="@color/opaque_ red"
android:text="Hello, World!"™ />
X AT @ W AT A2 W BRG] - S T SCA R BRI 44
@ [package: ]type/name. XHEEANIAFER CH, FABRINHERN A KA
HEIHEE. N TIRE - DRGERE, RHEINES:

<?xml version="1.0" encoding="utf-8"?>

<EditText id="text"

xmlns:android="http://schemas.android.com/apk/res/android

android:layout width="fill parent"
android:layout height="fill parent"

android:textColor="@android:color/opaque red"

android:text="Hello, World!" />

TN AT, A ARAEAT SR S A R AT AR IR S, XA R
A BERLAH] -

<?xml version="1.0" encoding="utf-8"?>

<EditText id="text"
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xmlns:android="http://schemas.android.com/apk/res/android

android:layout width="fill parent"
android:layout height="fill parent"

android:textColor="@android:color/opaque red"

android:text="@string/hello world" />

KB A IR B BR8] 51 o Bt FRATTREIXRE G R B A -

<?xml version="1.0" encoding="utf-8"?>
<resources>

<drawable
id="my background">C@android:drawable/theme2 background</d

rawable>

</resources>

FERESH

T3 MR EUE SOV UR 51 2 A R PR XM & I 51 R BRSO TR 0 B
PRIELL R XML& A s & SC VPR AR S B 25 AU R A 1l R UL A2 A5 BE A A
111 AN PSP K ) L AU

XA, BATRELEAT R ST R SOAR Bt B B O H A 22 48 1 U 58 S
PRAEZIEL

<?xml version="1.0" encoding="utf-8"7?>

<EditText id="text"

xmlns:android="http://schemas.android.com/apk/res/android
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android:layout width="fill parent"
android:layout height="fill parent"

android:textColor="?android: textDisabledColor"

android:text="@string/hello world" />

EREERRBATR AT 28 7@ HA AR F & 5 SI H. JREHZX ML, &
Gix HEh BRI MR RIEN 27 - SR THRAIES €20 BEREAS S,

PRA T EVEIEE (?android:attr/android:textDisabledColor).
A5 FH B YR AR VR AR 2] 3 i B 2 R B A i AN 2 LA R A, HaE VR
'@ P SE—FE): 2 [namespace: ]type/name X B type J& o] EHEH].

5 F R A BHR
V2 G5V IRISFAR A T BLE FE )« SORE IO HEE L7 android RP IS L. 49

arn,  ARA] DU T ARRSAE B A bR — AR R N R B A
public class MyActivity extends Activity
public void onStart()

requestScreenFeatures (FEATURE BADGE IMAGE) ;

super.onStart () ;

setBadgeResource (android.R.drawable.sym def app icon);

}
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}

FIARBLIRI i, X BURES BEHRE IR 1) B 4 AL il 2R Gt 0 SCIIRRAE (Rt 15 57

H3

public class MyActivity extends Activity

{
public void onStart()
{

super.onStart () ;

setTheme (android.R.style.Theme Black);

Xt T AR HE SR E SRR F KRR

PRAT CURR I 7 it ST 1 5 DA SR A E B e E AN R I BRI R, BRI DL
AFR T E AR AR BHR, EIFRE (SDK) Axg ik AL E
ANTR] R B IR 25 N Android Rl R A BEF LA R A BLAS B e B A3l 1 e B I
R AT LR Ve g b B S T R AN R S

LG ARMBI, R BT OEIHTRSCER, EEA AN LG
45, XML TFRRY—SRERFE (ES, JRGREFESE) o fla, X5
FRIT H 745 B SCPF— SR S SRR, 3 SRR SRR :

MyApp/
res/

values-en/

strings.xml
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values-fr/

strings.xml
Android SHRFANFIZEBYRMBMTE, JERT U2 SRAE SO R ARG TH, BTS2
[ DL A5 20 T o Bl — A2 B 4 7 4 00 B A4 Pk i 44 2 AR b
MyApp/

res/

drawable-en-rUS-port-160dpi-finger-keysexposed-gwerty-dpa
d-480x320/

SR, ARAT DAY FE 8 B 0 v O EC B I R EEARAIE T AT () BB # 2 #2I5t
FrHE] -
My2App/
res/
drawable-en-rUS-finger/
drawable-port/
drawable-port-160dpi/

drawable-gwerty/

BB Uizt

L WANNEZEBE 1ISO 639-1. flUl: en, fr, es

Hi X A K G 7 8/En E—ANg 78 ISO 3166-1-alpha-2. 4l
W rUs, rFR, rES

751107



http://www.loc.gov/standards/iso639-2/php/code_list.php
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5% ] port,land, square ?

i 92dpi,108dpi, %,

finh 453 57 R Y notouch,stylus, finger

B ETAN keysexposed, keyshidden

& VN NN nokeys,gwerty,12key
P

Tl 5 1 32 notouch,dpad,trackball,wheel

=
St

YA 87 . N
FRARE | 320x240,640x480, B4, KAWEFEIFLMHE

EANFNRAG G — LR RS, gk, bR, W&MieE, HlEe. LM
FHAE 7 75 BN TE (5 B AR TE SIS 15 A Ui .
X B — 2@ e T RYR B X 248 S
o HBMNTEHBEITS T (FANEANE XA GRS
o« WEINEHUE (HKNEFDLIHEE—FD
il 4,

o —drawable WJHFWAr %N drawable-port, MAZE

drawable-PORT,

o PRANBEE /N H 4N drawable-port PAK

drawable-PORT, HE#HE ¥ port" Fl "PORT"H NAF KIS Hh
ANAT Ao
o AT HRE-ARRBME T A —AMER A R TRARETE E R XFE
drawable-rEN-rFR/)
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RAT AR € 2 NS 80 2 8 AL E, HRSHLAUE EIHRME B,
1, drawable-en-rUS-1land = E{E US-English FIHLES B %A X
AL .

Android = F & & 4 ATACE N B3, XfE Tl

T B SI S RO FORFTRET A AR 1R 2 AR R B, (B il
D)

i H3, LR GIR, ARG, RELE res/ HETF.—LH
FAaNBERER (XFE res/drawable/drawable-en ;& ANA] LLH)

PP B BERAEARA RS 51 T rh e b A6 P 3 500 L Azt 425, sk —
B R AT 4
MyApp/res/drawable-port-92dp/myimage.png
BRG]
R.drawable.myimage (code)
@drawable/myimage (XML)

Android TR BB EEHKTH F
Android $#2 8k H P LE I AR SR SR AT 2, XK LRI E . i
EESUN LI

1.

N

w

NS

(o

M2 — Se AT A FT S BCE AT S ISR B, R RIERERR

108dpi, XA LR MyApp/res/drawable-port-92dpi /.

MyApp/res/drawable/myimage.png
MyApp/res/drawable-en/myimage.png

MyApp/res/drawable-port/myimage.png

: : - . . .

RS RAE AT ERCE IR, Bl WORIATHIHIX R en-GB, U5
A5 port, ARHATAH PIANFT G Bl B 14T -

MyApp/res/drawable-en/ Al MyApp/res/drawable-port/. X
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MH® Myhpp/res/drawable/ A LAHEMIER T, BAYS A —DFE—
RULECIERf, TEEA .

7. Mylpplres/drawable/myimage-png

8. MyApp/res/drawable-en/myimage.png

9. MyApp/res/drawable-port/myimage.png

10. FR 4 FC B 100 S 90d B 2438 & 1 SO, B AT TR A HEZ1I AR L T 3R 4%
B, B, 15 S UCHCE 5 A VCEC S B, AT DAFRATT AT DL i 1 RS
= kE4T, MyApp/res/drawable-en.

11. MyApp/res/drawable-en/myimage.png

Lo Ehpedres/desneblo—nor s Sraimace ey

Rig

TR RS — RN N BB AL — R U A B e B SR D Re, K RIEAT
TIREEAN R G XA — S O LS AR RO U B, ARFETT R Ao ] R i
FH £

B SCHE: BRI BT AR AL . 1K E BT M java FE T g 12 ) B AR S
fF, BHE (1 PNG B ), XML S5, IR ST A DL—Ffks i 1 7 N 7
fE—ile, ERFITEREN, ENIHITER—MSLE) ZIP S0,

aapt: Android A XHITE TR, XN TAESAERAREFT 2P XX BT
I OB ST B, AT VR R & s L.
BWIRR aapt LEERRFERISCHE, f#R T EERFIE RN, XA
Al DU RIEFOR VI B ANRE BRI N R P R

B RER B — Rl IR R R — i A . KR b, RIED AR B
PR A, 285 ).

BEVRARIRAT: 7E BT R BLTA (1 SR A v — BB bR iR . BT A (%
JRHEIR, XML ST, Java JEARRS) /R AT DB B F 755 44 108 B SE B 808U
FEARBIR: A AR BHIEER ] AR 5 e — AR B - e, 8 — s A =UmT DA
BRFIERG BEMAFIEREART. B, g, 75, LmEEM5IH, %
o BER LR XML $iR SO IR B85 2 BRI, B DLEE AR 7 5 BRURAE A7, ST
LA A2 AH O f 2B SCAF IR R A5
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BB A AR RSB B, AR TS, mRa - MEENA T
PEAERCK A3 o BN EUE W] DI BB AR B 1 B bR IR, BB AT AR [ 2R 7
1745 R s IR A — IR BB AR BRSO 4R — M B Bl
A LAt G0 L kK, AR PR s T R RE R AR B R E AR

R BRI T A R TR MR IR RAT S W BN, 2 SRR & g
IR AT B, P LUK S5 055 i 0 LU i 1] IR B0 XML SO (0 74+ £ it 45
B st . HeH LBHHESEALR P CRIML TR E ) , Bt CGEAH
), A7 MR XML S5 § #Ae, e — P S Bk
RS (AR DB MR B o AT MrdE N attr SRR,
EE T i A4 BB AL XML J& PR BRI AR TR AT o

DA% S AR BRI A 7 R R — R AR P g . B, —A
TextView (ISR A] B AT — IR F 1 XS ISR E SCCAR R, B LR 55
Jie AN FHIAT R XML SCPE A, a] AR A% o P SR ff g 28 4 5 T X
1%, B HIE A KRS BRI 44 7

RASR: X HEAR TR — L Jm M BRI . SR A SR BHRR A B, T AE
PR e LUF R R U L, X AT U R KUK SR BE XML (R RREE e 1 3L
TR EIERE. F4n, Android T & BLUE L T MBI XSS, e S
AR ERL R R e X, AL, T 5eE . XAMLEgAE A, el
fir B AR 25 A XML 3OS Ee 4 LB B s il v

BCE: XVFZ RPN BHERS IRAT, ARIELATIECE, WA ZMARIE. KA
BRI GESMEZ , BRI, FEadg, &% Suiine e Rk
BB PRR BN A SR AR

FERB: —AARUERAL R BHIRBE N — MR R ORIt R R E. flln, %
N TREITS — &SI, e MR R, A ) sl B
EANRMBER MR ZE LD, WhHAT SR EUE, BOASCRB, 1241588,
SORGHHAERA, SRR, &5 S E ARG RN, EB4F CORgit, &
RBE, R B BEARE T A, AR AR XU B
Ja AR T AN T8 ) Je 1 R A

B/ WIRAREE ORI, (AR URAT DL H Al R B e R U . ook
BECEE, Xr] PR EHR AT EREIMABTHIEC B (a0, ode s of 25T
HIALED , BHIUAE (B, Rebrer 3 61 58 Hello Kitty' )7 5
Fo o, BRERIEG (BlinE s 8 AR RN, AR 18p) .
KPR SV R SRR G AR AR, B N B AR

RIR 5 H
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BRG] XA AR 7 AR IR TR SR, IRSEAL T AT e Java fX
Bt A5 9 DA S n e 51 P B R A A

B PRt A A 4k

BRE 52 8 B AN A AL R AR SSBE R, (EILAER) SDK IEBCA 56 4 SCHF T -
4 SDK AR, XAFEFTLAS Android “F & BB AL A OGE 2. I
I, AhER T H DL R R R S AR 2 A5 B AN B R AR 15 A R

=. FRIEME
Android ¥+ 3 %

P 2 A AR HOR L, (ELR AR AP @R R 3 ) R K
USRI Mok, ARAETR: R, ROZAINE A AP SSBLIRIThRE
U BTG AR . B, BRI % S B SR
CT RS FTRLS IFEAR 25 55 SRR LI 2 AT BN S LA B R«
HIELTT 2, 35 BB (3 (PR IERN 7 ok SEO AR R ) B0 A R B
R, (BRI S R ITHE S R, JUHER, 28 IR e A . 48,
B A% 31 ik, AN 0 B3 B L 0 4 2
T R 4T ORI LR

TEBE2 T, JF B WD B AR LR (RO PP .
Android FIBAKIEE T — M % I GU RSN, % S0 PP R34 e T
PR R 2 [RORZE T B, BTSRRI HERT 1o S R S TR 7 075
P S

SEO PRI ZAROHAE b 1, #i; 2. WAZ: 3. AR 4,
EMHSEBLTIEIR, A 6 08 2 i 2 = M iR . R,
£ SISV 107 K AT TR s TS 22 56 100 4375 Android F-£3 T I
IR RV R PR I e B s R

P (Fast)

Android 2P HAT N IZ AR . 298, UERIR LT IR NAZHAT ARG 20X
(BREAZPO o 18 Hr e ELH A B X B —AMiie] . FRBEE R B R RE S
B LR IRATT T A 0] A8 o 224 3 At ) 3 31 ik N 0N FH R P TR, BE R s ik
BHAHGIT,

5 ST AR 55 N R RE P A — 5, BE R e e R sl 15 25 W A2 7 B i A =2 OB &
1o PEIRERESERR PR T RN E RN, CRARS e: MEENE
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PRI, FESS 7€ (1 HL S RUST  Ti AT DA BE 22 R FL B o X 5 TR 55 B FH R T
KL, BRI SE: IR AT RS 2 s B — RN EAZ S A B,
FER) 3R Ry, HAAR R — SR RE 2 B St e X U T WU A A R H
REFFRUL, RS, S EEZE RN TR A8 B/ o IXFE, BEE O 32
fRIfR i, A R D RE RS 2 AR A RIS, DIFEoBORBSAIG, AT (8 T L R
KN, LRI RFE AR IR TRDROROBA o IXRR 03 BT R iR A U A T S5 T &R
R UL AP PRt SRR AER K. AT, )R Ui sk, B
IR FE R RS B 2 D REANEE /DT e, R R

XA FATEE S H R A S5 BT AR AN BE R ST O R T £ T T ) B Tk e
JERNSE 55 RLFHRE PR —FERS . — ok, AR RS S/ NI LA o
W, BEWRERIER RS, RRAEEE 1 R YR 5 R gAY > 15O PR RE A S
AT T RO SOX AR ORER AR, KB 0 I 1 TAR #7040z 1 B, 5 58PR
AR, (3R S S8 AH SR

£ "5 = Android” —3CHT,  FRATT2 XS LR 1A 4

. (Responsive)

BATAE FTRERE S 20 'S A5 tH 5 L BT M IR A0S, H& B P i A R R 2 R
BRI K, IX A PR R R FR P B R85 B A 71—k NI J R g, 75 DG gt
(RN 22 R, B AbF A N OKTE . 76 Android “F& T, ISR i 7 AN 1) S FH A
422 " Application Not Responding” (ANR)IX F: i S0 i B .

W, XS TE N R F AR R S AN SN R A . filhn, ARSI AR
7548 1/O #E b (Mg Bz D PHZE, X2 ELFBA AT %A
HE, —BNEZENH RGN NIRRRT R 1, s — MMk A
Wi SERE . FEAER, SRR HETF AL TRIR 2 I8 /] M 8 N A i —
SEM). BE T RIRN T —0, X RAFRESUWNET CEHER. a3 L
1B UL, R OR T S s e, (R RS 2 A vy R ARt 75 AR Z s (1]
7 L TH N7 8] S R e T o ST AN TR FER A B G A 0 AR, IX
FERLRE CRUER B L2 (W S P AR ) —HigdT, ZFERT ik R AR
By oa@ih. BONIXPERE RS — R AE“ZE” (CLASS) XANZIR b, /RAT LA
LR 8 2 B I ) R AR HE GX L, W] DUR 77722 IR IR I 2 A M REAH EL D)
ZKHE RN RMNE, £ DN Android TR —SCHXT TR HE
J R e 2 A VR R A4

T4 (Seamless)
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RS2 AR (1 N FE AT AR R, I B AR i i i, B AT SR A AT e 7 v
Mo —ANE WB T2 5 &R FE (L 40 Android /) Service #
BroadcastReceiver)X} £ S AF A G TRARFRH — A UL R o X BLF 2 B0 5
B, I H BT RE SRR R IER 1, FONATE 2R T s (/] 2 R
i B SN AR . &, Android 3 FHFE PR 1 # 2 RS fe v L 7E AN
5] S AR P 2 BT IR D)4 . X ERE , IR J5 & HERE ST BR 3 H A
AN UL, P AT REIEAE RS, i — S A S, nfeded
Wio BBE—F, W SMS 5B IRER AL A BAE N H — XS HE, X
IR BPRE A P R . X2 A4 Android FRifE s T B S5 A 2 0
(Notifications) #Lill; XM FH /- et B 4.

AR =AM T, AL B F 2O S, bedn,  an s Activities Y& 1 1 5K
Pl onPause () /7 A H A A= dr A HA 51k, 10K & SRR E R . 308 WK N
FARE P B 2 B Bm 45 AR S, FHAZ P A R A% H — > ContentProvider,
T AN FH— AN N B 0] DL ) A I sk ) SO B0 4 1

XA — AN [E] FRE A5, AT K BIRE i SRR P AR 5 R 2 MR
B RGN 2 AN HFE P — R f & A S, A KR
MRS X RVHERIT RN B RS EAN RGEAE 2 — IR LA AR KBS
X VFART- g 5, Toag it AL N R T 456, I RAE BT H OS5 M2
F o

AL —Fh A AR (5 PERERN I B 1 B2 KR 222 IR R o TR
FEgnS LA MERER MRS,  “H5 RS —CHBSXT it ANra, et
ARG I A i A4 5251

YR B & XA
Android 1, RN FTRFEIE TS View K444 & —FhE g R, izl
(Button) . SCAHE (TextView), AI%a%H CAME (EditText), FIFRAE (ListView),
S i%ME (CheckBox) , HLi%kHE (RadioButton) , J&zh% (Gallery) , fifizs
(Spinner) , %%, IoF —S e A E Rk A& R View 44, 410
AutoCompleteTextView, ImageSwitcher #1 TextSwitcher. [tz 4, Fp%
Zg &lEAi)s (LinearLayout) , HEZEAG)S) (FrameLayout) , 1XFERAR R4
fF (Layout) W#IANEZ View HA4F, 12 M View FEIRA T KT .
AR ) L P R e Tl e 3 2 ) LA R0 A oy LA DA R A O s & Bon e i b, — R
SRR IR L 21 A KR SR Ut AR 68 FH 5 A2 /R A B 2% R R A2 T DA I S 4k i ) 4 I
T HCRAM, —&ATLL4kE View. Layouts (ffi R ft) XFEMIA:, HE
Al DL — S LA R s i R A A . R TRV — T o4 B4 K

o ARATLUASEIL R DhRE G — AN 58 4 B SO A A, ) an A — 4k i 1A

T g 4 o) AL A S TR o s ], AR AR R — A
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o ARATRAE LR AT 255 T e— AN B LA, IR B 44 T e R i A 2
ComboBox (—AMREHI A AR ) F1 dual-pane selector control (/-
HWAS List &L, ARV RLE OB —IRMNERR) F5.

o RATLAGIEE H ORI m44t: (Layout) o« SDK A R4 O Rt T
— ZRANMIETLERFT G JE T B S SRR, (B2 =R RN F2 K
RIEDE B Layout 214 FF & 0 Layout 24 R IRE LR, BE 2%
MR JZ T BB BT

o ARATLAZE & — NI AR BoRsiTige. B, oA EditText (R] 4L
A AIHERHE ISR (ATLAZ% Notepad (O, HLIH ki
AR — A TR R T .

o URPT DAL AL T IXFE R FAT,  Dh—S8ii H i 7 VR A X Le A
NIRRT o

N T SEIHEA H AR AT REIR A LY R — A DA AFAER View A, T HIFRATE
B L5 T BRan e £ A

N2

FAFH ¥ (The Basic Approach )

24 H e X EME (Fully Customized Components )
& i 4H 4% F  (Customized Component Example )

HAERIRE (REEHENES) (Compound Components (or Compound
Controls) )

B A HHE (Tweaking an Existing Component )

/NgE (Go Forth and Componentize )

# A (The Basic Approach )
) LD RAR LA EE, FR T e B DR A
1. iERAIZE (Class) dk&—NILA R View 388k View T35,

2. BB —LeIyk: FEBEHNETTE KL on’ 3k, Wl onDraw(),
onMeasure()fl onKeyDown()Z54&,

o IXAME Activity 50Ul ListActivity JEAE T FEIFEEH , RTEEREE—
s A iy ) U BR BORD — S5 HAh Th BEE 1) HOOK pRI% o
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3. fERARIIARASS: — BARKIGR AR e B, PR mT DAAESE S AE 8 5 H )3tk
JifE R4k ASE, (H5E N RERE IR E SRS 1 1 o

AR ERENS € XAE activities BT, XAFIREER TR, (HERXIFARBE
) CBRPFERI N AR 7 R R A A0 — AN A AN AT DLE A A

EL&EENHAM (Fully Customized Components)
4% H 8 XA AT LA — e i T BRI EE 4l 4F (graphical
components) , WV —MEHEERMEILIFER, B ERH OK B 2R
AR B/ NERBE A B SRR BN o TR AN 7 20, VRt AN B 5 4l 1 R FH A 1 45 5 52 R
TR EA GG IR B A
SEiafE, R LCUMRE S ERZm il g e g T 3 Aalr, e kRIA
i I R IRIAR R 77 BRI RS A AR EE 28 11 e Qe BRI N IR i Ja A
STEAR L B TS 1 FE N 1P & ETHIEAT) -
T A B WA T 3 TE A E s LRI
1. ENEME VIEW KRR ZTEE N View 2K, KL, SITMHIRERIE
—ANET IR — TR,
2. RO RLE — /& R XML X SREUE A28, SRRt T BLH
CUE SOX L RS E (W2 BT E S R B E A R, 8iE 2 RE 1
U 5 R 52 4545 )
3. (R LTS 1 T 52, 0 B R o R — B0
G IhRe LA .

4. WRARA HHMFRENS BoRAT A KT, RRAATRES E . onMeasure ()
A, IMARASAER onDraw () BR#E. A BREES BN,

M2 onbDraw () REEASHTMEE, HEHBIAP onMeasure ()

BB HZNHIBE T > 100x100 —HI R, XA RS AT REFF A AR AR 2
i

5. HAbALEREBK on. .. RIIKEHT LEHE —IK.

onDraw () fl onMeasure ()
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onDraw () EREUG AL ER—A Canvas X%, I EURTE] LAE 4 E K F i
RS, ARG HAR A — Se bR vE RS B 4E . SCARRIRE S, AR AR AT PLAR 2 f
ZRPEES AT LIS e S .

JEEL X EONRE = 4k B A SRR RS = 4E T, RN AIZAER A S View
Mk SurfaceView 2, I HH—/M LI FE . 71T LS GLSurfaceViewActivity
141

onMeasure () EEHE SBF, KNS & EURARIL RN 25 83 28 B 1 <8

7, onMeasure () NiZE#L, 1LEREW A RO HERM PRI E Frel & 5o il =
B XWANERT, FANRMAMEESEKM RG] (GHiL onMeasure ()

FEIERI) , [FIRFRATN ZEE — B = v A& R, BB

setMeasuredDimension() /7%,

MEFE ISR E, AT onMeasure () RED N— F LI ER:
1. B onMeasure O HESWRA, &A% E S HE B W20 &3

(widthMeasureSpec M heighMeasureSpec RO R T ES

B, [FIRRNAZ S AR RS R il . 1X I N A R LS5
View.onMeasure(int, int) CGXANER: NS RGN fRRE T 8
measurement #:/E) .

2. RIIALFEEN onMeasure O 1HE1SF|VE ) measurement £ & A

8L TR RS VR, B RS AR OREF— 2, R e DASEEL—
RS USRI e (FEX AT B, SRR iRt BAEBIY). 3.

A H B A FERZH Y — R IAH onMeasure O KED .
3. —HEEMBEEME R k)G, YA
setMeasuredDimension (int width, int height), Hmte 5

B

—A~ B B ABHIBT (A Customized Component

Example)

£ APIDemos '] CustomView $24t 7 LL—A~H & XAHAIH T, XPMHEHE
AR LabelView 2EH5E S
LabelView |13 & 2 1 B x& XA 7 5 TH 1H :
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o HIGIEAE XA View FEHYRAE H K.

o TWEHWSHWMIERE (SETUCKIET XML XX o X B -—i4b
PRAS VA AE View EF5ERKR, (HATIRA L Labelview 1§ FH i H & XA
A TET I S5 T b,

o —LEFRUE Public %L, #IH setText (), setTextSize (),
setTextColor ()

e H# onMeasure () FHSREEHMHRIN ST (GEE: 1E LabelView H /2

B PN AE R measureWidth () SRSZHLH)D

o H#{ onDraw () REIE Lable B~ EHR AL canvas .
LE T, ARATLLIE T custom view 1.xml E 3| H & X444 LabelView 1 7.
TE XML XA A By E 2 2 android: M app: NS ETRGIEH, app:

SRR N T RPN N2 LabelView AAEIANE, XSS /E AR IETE R
HKrbE Lo

HHEEBAR Compound Components (or Compound

Controls)

WERARA AR A — AN 584 B 2 AR, T2 i) LA I A4 14 & 72 AR 1 1)
P, MAREGHMFEARRENIE G . BRI, XL IA RS
B —/ N2 A B ] AR R — AN B At . B, —4 Combo Box 44T
AEAE 2 — EditText Al—/N5 A 58 H Z1I1 3R (1) Button AR &4, a1 SRR
s R P R IE R — T,
7E Android ', HSEAE HARK A View ZE0] A EIZELI R Spinner Al
AutoCompleteTextView,, {H & Combo Box {EN— Ml T 54 5 ik NFEfiE.
TN THI TR B A R 0 ] B s 4 A A
1. —f Layout 57740, G —4> Layout ZERJYRAESE . HIFFE Combo box
FATEE BRI LinearLayout /E A% 5. i, HAhK Layout 28
SRR DHRE R R, PRA AT DA ARG . R, 1B
Activity —FE, VREEAT LUE M35 XML SOk 75 B R 248, ] LLIRE
AR,

2. EFRR A NGRS, e, WA RSCRIMEGE R, A
XIS H SR W] LABCE IR BT A AL A A — 285 T, AR B
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EditText 2144, NAEWE)E PopupList 2044 . V& IRIEKHE AT LLEE XML
XA G | A EMEM S, X E RS T DR TR G 4
P A

3. Rt Er DG a] e W 4 25 R T BT AL R View SRR U, BiAn, XS
List eI FAF 1 W, AR ZBTAE AN 8] 28 = S8R EditText fRIE .

4. RATREGIE H O — L@, AU RABESOTE. B, RvrikE
EditText #1468 H B4 15 ) e k.

5. ff Layout BIYRAEFH, FREALEFZLEE onDraw () fl onMeasure
O J7ik, A Layout & LLRUF BRI EE . (HAE, WRIRESE 0
BARW T LEEE .

6. IREATREEZ L on RANKE, HlUEIT onKeyDown () FEZR, KA
DA o e A i 2 e B 1) 2R P IR L R AE

M2, 8 Layout BRAERFFEA T I LA A

o IEH0 activity —#f, YRIAT LB XML SCPF2 5= BRI A4, s IR
WA AR iR E

o onDraw () EREM onMeasure () RECER A LEREIN, MADRED
LMARIRET T

o ARFTDMBRIG IR IR S AL, HH Al DG s —HJ A AR .

BEEHBERBF (Examples of Compound Controls)

In the API Demos project 7 APl Demos L2, HFA List 21411
——Example 4 1 Example 6, HIfi[f] SpeechView A1} & M LinearLayout &

IRAEE R, LELE R ERIIEE, MM AEARISZ Listd. java M

List6.javas

WEMNEHM (Tweaking an Existing Component)

FERLETE LT, AR A REA SE MR A VA L IR AT AR 17—k
HRLR AL, AR P ZEA ) R ] B MG AN LA IR AR AR 4L, AR —
L BB TS B e A H R U T VE VR AT LRI R SEI, (H I8 T
i View JRAEFAF I ALNE, AR DL BRI 2 A7 AE A AL BRI, IX AR
ARG VRITARELR, A BT
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filan, 7& SDK H—/~ NotePad [f1f7- (NotePad application ) . Z%fiTJ#
/N TARZ Android “F- & SEH VAT, FlaniRa =2 EditView JRAE H RE H 5))
BATHIICFEA . KA R —DERIE T, BN R B RASK G, XL API
O TIRZ, (HEMSEUii 7 — 5 n .
WRARIER B FZIET, WAEVRH ] LALE Eclipse R AL FHAGIFE (B
AL BE 2 A B AH B I YRACAS ) 7 1) 2 5 & NoteEditor.java H I MyEditText
HE Lo
A LS B T
1. 7B (The Definition)
XA N AT AR R E S
public static class MyEditText extends EditText

o  BHEENAE NoteEditor activity KEMM, EREEILEM
(public) , Btk RA BE, Er L@

NoteEditor.MyEditText M NoteEditor #MEIHA

o TR static % (AR , MU & HILHT IR LK
BRI RER SR — T LA AR
NoteEditor MK, % T/ EMANIATI I M AIBA I 1L,
B —AMRHITHL S B, GRAERT RIS, IF HL Ao Ve AT LA
(GESH TR

o EREditText KIUF I, ERRAVEFNARA ELHRE.

HIAITER LG, B SEHta] AE N — BN BEdi tText RAEH .

2. REFIEE
ORI, R E AR BE— DR, IXAE AN ERIARIAIE B AL

M — SIS R . BN EditText &0 M XML 1 5 SCH4R
B RS20 AT 08, DRI AT T A 3 oR £ B 22 B S 3801 B iX 2
Mt b XK,

3. HHEEHR
FEAM, AXKE onDraw () —ANTIEREATEE . EARAT LR 2 5 HON R
5 I EL A LA R R
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X Fic ARG Tk, B EE onDraw () HERATAT UL EidtView
HIE A (canvas) L&l B2k 5k (canvas FEBITE S K onDraw ()

TEAEE) o ZRBIRE LR EH super.onDraw () . XM

THEAENAZ AL, AERAEIX AN B, FATTRAERATRILF 1 82 Ja i
I

4. e w4
B, BACahA 8 Qe 7, (BN ZEMEHER? AidFEA
Bl el FI AT ERAEIUE RAT RS A, AR —F

res/layout HEH ] note editor.xml ff.

<view
xmlns:android="http://schemas.android.com/apk/res/an

droid"
class="com.android.notepad.NoteEditor$MyEditText"
id="@+id/note"
android:layout width="fill parent"
android:layout height="fill parent"
android:background="@android:drawable/empty"
android:padding="10dip"
android:scrollbars="vertical"

android:fadingEdge="vertical" />

o ZHEXAHMIE XML HRAE N —A— K View FERAIER, I
HoZE B A ERMERN . R BN RS
NoteEditor$MyEditText KF RN, X& Java gmfeH 5] FH IR
IR T 7%

o AEE S H A B YA S EUR AR 156 25 E T AL A G pR AL RS A
fE3) EditText #IE R EF, [RIILIX S S50t 2 /R i ] EditText 4144
MZE. FE, KRBTSR E S5, ATEAE T i
XA [
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R R AR AR A B, ORI — AN RG] BRI SCHEA : IRIRE R
AR, WA B E XA 2 A5k,

—ANERNERAM TR R EEBE LN on RANKE, I HICEIRZ KA K

Hok7e 5B E € SCHAFIIDIRE o ME— 1 BRI 02 VR I AR R /I AR TG B 30
A2 TAR.

BLFE R R RBP4 2 TRAE

GnpRET AL, Android SR (1 — kg X SCaR R AR, LR RIS AT RE A 58 R
I TAR. M R R RAMR S, SR EE XA, RIERZEHXLE
TR, RBLZ A PG 2] 2 2 S URAMILESR [ Android 27

Android “F & K HiE API

Android & H T &M &R FAL, M B B 2 & &m0 fe FHl. 0 m)
Android APITERFBFHLEE AT, (B4R —L5 AP E: 1 —SLhE 5 (1)3E
FHYE R . 3X A2 BT Rl iE AP,

XU AP Z fT DU “ATIE ", RERFN—NFRE &I — B B e A X 2k
APl, HEZET5REAE. #lw, —NFRR&TTRRA GPS 5 Wi-FI FAE{4F
TR, XEINREM APHERIEAE, (HASUMFER 7 AR TE. Flin
Location APIESRTEIRAT GPS (¥4 FAELE, (B AT fese &% 25 hfe il
i, BREIXIE APIFEEASREA R .

PRI N 812 TG B i I8 4T BB B AE — AN T BEAS SCFRIR APLII %, RUNAR )
W B EZE 0 (the classes) o 4ARPATER TR 4 WA, i
i — AN . A AP S A FRATAT LLS 251X 88 AP (UL SRS, AR,
ZGn 5 AR FE RG24 1 A BRI 2 v

Wi-Fi API

Wi-Fi AP AN AR P HRAt 7 —Fh 5 A8 675 A Wi-FI ¥ 25482 110 i 2 Jo 2R HEARAH
BRRMAFB . JUTAr ARG RS S E TR P, MRS
IP Hbidik. HATIRESES, o —LHART MG R . —Sn] RS Bk
AR B, RAE. iR R ER:.

Wi-Fi API7E android.net.wifi 9.

A RS (Location-Based Services)
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TEN RS VPR RIS T A B R R R BN e R % P2 FIREL
HERALE, HAHREEART . #la, AkHMe M RgmTiEsiesE, Jan,
AR AP D2 AN E RS .

SE LRSS API7E android.location 191

mi X B A E B L4 ¢ Android FELL AP S B

L4k APl (Media APIs)

Z AR AP 3B T AR SO . X R ELFEXS A (ki MP3 B Ath
IR SCA DA R AR 78 2 AR ) A CLn & M I N8 AR A ) SRR, 52
FE B EC URI HuhE" (Note:URI B2 45— BE R bl ) 2 x0— 7 2% 1 B3k
AR . FR FoRUE, 28R AP IEAZTTIER”, Fove B 282, H
S AR PR G b TR B AN 5] A g b R A ATL A R e S AT e )
Z {4k APIZE android.media 1.7,

piiX B A E B 2 % Android Z1E4E APLEI{E ..

FTF OpenGL K] 3D B (3D Graphics with OpenGL )

Android {3 E ] 82 CHEGE & — N SR Th] () 42 (4 I 2R kR R e, HAZEER
PSSR ER AR, BUORTEE T2 —MEaEE P 2D #1 3 D 446 1 ETE 51 %,

It HSZREREAEINE . FHR VI P& 3D Zhag API 211 5& OpenGL ES API, Al
Z IR API—H, OpenGL tHANE ™ 4% & X ER“ATik”, KIONIXLEE APl 2 s 247
755 H e AR L [ e I ThRE . HA2, — S & n] A REAF Ik 2R, (36 & A
15 e 2 S AR (1) S F AR P R R B

OpenGL [ API#£ android.opengl ] LLE 3.

miiX B & OpenGL AP 2H.

. 255k

A S R, A EAE

F.. API DEMO

The API Demos include sample code for many aspects of the Android APIs, from screen

layout to Intent resolution.

App
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Activity
Hello World
Demonstrates a basic screen activity.

Code:
HelloWorld.java

Layout:
hello_world.xml

Save & Restore State
Demonstrates how an activity should save state when itis paused.

Persistent State
Demonstrates how you can save and restore preferences, which are stored even after
the user closes the application.

Receive Result
Demonstrates how an activity screen can return a result to the activity that opened it.

Forwarding
Demonstrates opening a new activity and removing the current activity from the history

stack, so that when the user later presses BACK they will not see the intermediate
activity.

Redirection
Demonstrates how to save data to preferences and use it to determine which activity
to open next.

Translucent
Demonstrates how to make an activity with a transparent background.

TranslucentBlur
Demonstrates how to make an activity with a transparent background with a special
effect (blur).

Service

Local Senice Controller
Starts and stops the senice class LocalService that runs in the same process as the

actiity, to demonstrate a service's lifecycle when using {@link
android.content.Context#startService Context.startService} and {@link
android.content.Context#stopService Context.stopSenice}.

Local Senice Binding
Demonstrates binding to a service class LocalService that runs in the same process
as the activity, to demonstrate using the {@link android.content. Context#bindService
Context.bindService} and {@link android.content.Context#unbindService
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http://developer.android.com/intl/zh-CN/guide/samples/ApiDemos/src/com/example/android/apis/app/LocalServiceController.html
http://developer.android.com/intl/zh-CN/guide/samples/ApiDemos/src/com/example/android/apis/app/LocalService.html
http://developer.android.com/intl/zh-CN/guide/samples/ApiDemos/src/com/example/android/apis/app/LocalServiceBinding.html
http://developer.android.com/intl/zh-CN/guide/samples/ApiDemos/src/com/example/android/apis/app/LocalService.html
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Context.unindService} methods with a senvice. This also shows how you can simplify
working with a senice when you know it will only run in your own process.

Remote Senice Controller
Demonstrates starting a service in a separate process, by assigning
android:process=":remote" to the senice in the AndroidManifest.xml file.

Remote Senice Binding

Demonstrates binding to a remote service, similar to the Local Service Binding sample,
but illustrating the additional work (defining aidl interfaces) needed to interact with a
service in another process. Also shows how a service can publish multiple interfaces
and implement callbacks to its clients.

Senice Start Arguments Controller

Demonstrates how you can use a Service as a job queue, where you submit jobs to it
with {@link android.content.Context#startService Context.startService} instead of
binding to the service. Such a service automatically stops itself once all jobs have
been processed. This can be a very convenient way to interact with a service when
you do not need a result back from it.

Code:
SeniceStartArgumentsController.java

SeniceStartArguments.java

Layout:
senice_start_arguments_controller.xml

Alarm

Alarm Controller
Demonstrates two ways you can schedule alarms: a one-shot alarm that will happen
once at a given time, and a repeating alarm that will happen first at a given time and
then continually trigger at regular intervals after that.

Code:
AlarmController.java

OneShotAlarm.java

RepeatingAlarm.java

Layout:
alarm_controller.xml

Alarm Senice
Demonstrates how you can schedule an alarm that causes a service to be started.
This is useful when you want to schedule alarms that initiate long-running operations,
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such as retrieving recent e-mails.

Code:
AlarmSenice.java

AlarmSenice_Service.java

Layout:
alarm_senice.xml

Notification

NotifyWithText
Demonstrates popup notifications of varying length.

IncomingMessage

Demonstrates sending persistent and transient notifications, with a View object in the
notification. It also demonstrated inflating a View object from an XML layout resource.

Search
Searchinvoke
Demonstrates various ways in which activities can launch the Search UL.

SearchQueryResults

Demonstrates an activity that receives Search intents and handles them.

SearchSuggestionSampleProvider

Demonstrates how to configure and use the built-in "recent queries" suggestion
provider.

Files

AdvancedPreferences.java

AlarmController.java
AlarmSenice.java

AlarmSenice_Service.java
AlertDialogSamples.java
ContactsFilter.java

ContactsFilterinstrumentation.java
ContactsSelectinstrumentation.java

CustomDialogActivity.java

CustomTitle.java
DefaultValues.java

DialogActivity.java
ForwardTarget.java
Forwarding.java

HelloWorld.java
IncomingMessage.java
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IncomingMessageView.java
Intents.java
LauncherShortcuts.java
LaunchingPreferences.java

LocalSample.java

LocalSamplelnstrumentation.java

LocalSenvice.java

LocalSeniceBinding.java
LocalSenviceController.java

MenulnflateFrom Xml.java

MyPreference.java

NotificationDisplay.java
NotifyWithText.java
NotifyingController.java

NotifyingSenvice.java

OneShotAlarm.java

PersistentState.java

PreferenceDependencies.java
PreferencesFromCode.java

PreferencesFrom Xml.java

ReceiveResult.java

RedirectEnter.java

RedirectGetter.java
RedirectMain.java

RemoteSenice.java

RemoteSeniceBinding.java

RemoteSeniceController.java

ReorderFour.java
ReorderOnLaunch.java

ReorderThree.java

ReorderTwo.java

RepeatingAlarm.java

SaveRestoreState.java
Searchinvoke.java

SearchQueryResults.java

SearchSuggestionSampleProvider.java
SendResult.java
SeniceStartArguments.java
SenviceStartArgumentsController.java

StatusBarNatifications.java

TranslucentActivity.java

TranslucentBlurActivity.java

VoiceRecognition.java
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Content

Resources

Styled Text
Demonstrates loading styled text (bold, italic) defined in a resource file.

Resources
Demonstrates loading styled strings from a resource file, and extracting the raw text.
Files

ReadAsset.java
ResourcesSample.java

StyledText.java

View
RelativelLayout

1. Vertical
Demonstrates a simple relative layout.

2. Simple Form
Demonstrates a more complex relative layout to create a form.

LinearLayout

1. Vertical
Demonstrates a simple LinearLayout, with child width setto WRAP_CONTENT.

2. Vertical (Fill Screen)
Demonstrates a simple LinearLayout, with child width set to FILL_PARENT.

3. Vertical (Padded)
Demonstrates a LinearLayout where one of the elements can expand to fill any

remaining screen space (weight=1).

4. Horizontal
Demonstrates a horizontal LinearLayout, plus an expanding column.

5. Simple Form
Demonstrates nested layouts to create a user form.

6. Uniform Size
LinearLayout which uses a combination of wrap_content on itself and fill_parent on its

children to get ewvery item to be the same width.
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7. Fill Parent
Demonstrates a horizontal linear layout with equally sized columns. Some columns
force their height to match the parent.

8. Gravity
Demonstrates a simple linear layout with menu options demonstrating horizontal and

vertical gravity options.

9. Layout Weight
Demonstrates how the layout_weight attribute can shrink an element too big to fit on

screen.

ScrollView

1. Short
Demonstrates scrolling screen with buttons altermating with a text view.

2. Long
Demonstrates a longer scrolling screen similar to ScrollViewl.

TableLayout

1. Basic
Demonstrates a basic TableLayout with identical children.

2. Empty Cells
Demonstrates a TableLayout with column-spanning rows and different child objects.

3. Long Content
Rows have different number of columns and content doesn't fit on screen: column 4 of

row 2 shrinks all of the other columns

4. Stretchable
Demonstrates a TableLayout with a stretchable column.

5. Spanning_and Stretchable

Demonstrates a complex TableLayout with spanning columns and stretchable
columns to create a menu-like layout.

6. More Spanning and Stretchable
Similar to example 5, but with an additional "checked" column.

7. Column_Collapse

Similar to example 6, but now with buttons on the bottom of the screen that enable you
dynamically hide or show columns.

8. Toggle Stretch
Demonstrates toggling the "stretch" value on a column tofill the screen width.
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9. Toggle Shrink
Demonstrates toggling the "shrink" value on a column to make an over-wide table

shrink to fit the screen size.

10. Simple Form

Demonstrates using a table to design a user form.

11. Gravity
Demonstrates the use of advanced gravity attributes, such as center_horizontal and
right|bottom to align cell contents in a table.

12. Various Widths
Demonstrates the use of elements of various widths in a table.

Baseline

Demonstrates the use of the android:layout_alignBaseline XML attribute in various page
layouts.

1. Top

Demonstrates the default baseline alignment in a simple LinearLayout with items at
the top of the screen.

2. Bottom
Demonstrates the default baseline alignment in a simple LinearLayout with items at
the bottom of the screen.

3. Center
Demonstrates the default baseline alignment in a simple LinearLayout with items in
the center of the screen.

4. Everywhere
Demonstrates the default baseline alignment in a complex LinearLayout.

6. Multi-line
Demonstrates a baseline alignment with a multiline field.

7. Relative
Demonstrates baseline alignment in a RelativeLayout.

BaselineNestedl1

Demonstrates baseline aligning specific elements in three parallel vertical
LinearLayout objects.

BaselineNested?2

Demonstrates baseline aligning specific elements in three mixed vertical and
horizontal LinearLayout objects.

BaselineNested3
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Demonstrates baseline alignment within nested LinearLayout objects.

Radio Group

Radio Group
Demonstrates using radio buttons and capturing the selected item.

ScrollBars
1. Basic
Demonstrates a scrollable LinearLayout object.

2. Fancy
Demonstrates a scrollable LinearLayout object with a custom thumb slider image.

Visibility

Visibility
Demonstrates toggling the wisibility of a View object between visible, invisible, and
gone.

Lists

1. Array
Demonstrates binding a ListAdapter to a string array as a data source, and displaying
the elements on the screen.

2. Cursor (People)
Demonstrates binding results from a database query to a field in a template.

3. Cursor (Phones)

Demonstrates binding multiple columns from a database query to fields in a template.

4. ListAdapter
Demonstrates implementing a custom ListAdapter to return View objects laid out in a
custom manner.

5. Separators
Demonstrates implementing a custom ListAdapter that includes separators between

some items.

6. ListAdapter Collapsed
Demonstrates another custom list adapter with that returns expandible items.

7. Cursor (Phones)

Demonstrates a list adapter where data comes from a Cursor object.

8. Photos
Demonstrates a list activity that uses a custom ListAdapter, setting the view for an
empty item, and also how to customize the layout of a ListActivity.
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Custom

CustomView
Demonstrates implementing a custom view subclass.

ImageButton

ImageButton
Demonstrates an ImageButton: a button with an arbitrary graphic on it.

Date Widgets

1. Dialog
Demonstrates the DatePickerDialog and TimePickerDialog picker dialogs.

2. Inline
Demonstrates using a TimePicker directly in a layout without using a confirmation
button or dialog.

Gallery

1. Icons
Demonstrates implementing a Gallery widget and extending GalleryAdapter to create
a custom class to serve out source images to the widget.

2. People
Demonstrates populating a Gallery with images from the contacts photos.

Spinner

Spinner
Demonstrates populating two Spinner widgets with values.

Grid

1. Icon Grid
Demonstrates populating a GridView widget with a list of applications using a custom
ListAdapter object.

2. Photo Grid

Demonstrates populating a GridView widget with images using a custom ListAdapter
object.

ImageSwitcher

ImageSwitcher
Demonstrates using the ImageSwitcher widget with a custom Adapter.

TextSwitcher

TextSwitcher
Demonstrates using the TextSwitcher widget.

Animation
1. Shake
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Demonstrates a simple tweened animation (android.view.animation.Animation).

2. Push
Demonstrates a variety of transformations (android.view.animation.Animation),
including fading, motion, and rotation.

Controls

1. Theme White
Demonstrates a variety of common form type widgets, such as check boxes and radio
buttons using the white theme.

2. Theme Dark
Demonstrates a variety of common form type widgets, such as check boxes and radio
buttons using the dark theme.

Auto Complete

1. Screen Top
Demonstrates the use of AutoCompleteTextView, an autocomplete dropdown box

below a text box, with data taken from an array.

2. Screen Bottom

Demonstrates an autocomplete box above a text box.

3. Scroll
Demonstrates an autocomplete text box in the midst of a vertical list.

4. Contacts
Demonstrates an autocomplete text box that gets its content from a database query.

5. Contacts with Hint
Demonstates an autocomplete text box that understands the * wildcard.

Progress Bar

1. Incremental
Demonstrates large and small rotating progress indicators that can be incremented or
decremented in units.

2. Smooth
Demonstrates large and small continuously rotating progress indicators used to
indicate a generic "busy" message.

3. Dialogs
Demonstrates a ProgressDialog, a popup dialog that hosts a progress bar. This

example demonstrates both determinate and indeterminate progress indicators.

4. In Title Bar
Demonstrates an Activity screen with a progress indicator loaded by setting the
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WindowPolicy's progress indicator feature.

Focus

1. Vertical
Demonstrates how to block selection of a specific screen element.

2. Horizontal
Demonstrates how to change the order of which screen element is selected when the
user presses arrow keys.

3. Circular
Another version of Focus2.

Files

Animationl.java

Animation2.java
AutoCompletel.java

AutoComplete2.java

AutoComplete3.java

AutoComplete4.java

AutoComplete5.java
AutoComplete6.java
Baselinel.java
Baseline2.java
Baseline3.java
Baseline4.java
Baseline6.java

Baseline7.java
BaselineNested1.java

BaselineNested?2.java

BaselineNested3.java
Buttonsl.java
ChronometerDemo.java
Controls1.java

Controls2.java
CustomViewl.java
DateWidgetsl.java

DateWidgets2.java

ExpandableListl.java

ExpandableList2.java

ExpandableList3.java
Focus1l.java
Focus2.java
Focus3.java
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Galleryl.java
Gallery?2.java
Gridl.java
Grid2.java
ImageButtonl.java

ImageSwitcherl.java

ImageViewl.java

InternalSelectionFocus.java
InternalSelectionScroll.java

InternalSelectionView.java

LabelView.java
LayoutAnimationl.java

LayoutAnimation2.java
LayoutAnimation3.java

LayoutAnimation4.java

LayoutAnimation5.java

LayoutAnimation6.java

LayoutAnimation7.java
LinearLayoutl.java

LinearLayout10.java

LinearLayout2.java

LinearLayout3.java

LinearLayout4.java
LinearLayout5.java

LinearLayout6.java

LinearLayout7.java

LinearLayout8.java

LinearLayout9.java
Listl.java
List10.java
List1l.java
List12.java
List13.java
List14.java
List2.java
List3.java
List4.java
List5.java
List6.java
List7.java
List8.java
List9.java
ProgressBarl.java
ProgressBar2.java
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ProgressBar3.java

ProgressBar4.java

RadioGroupl.java

RatingBarl.java
RelativeLayoutl.java

RelativeLayout2.java

ScrollBarl.java
ScrollBar2.java
ScrollBar3.java
ScrollViewl.java
ScrollView?2.java
SeekBarl.java

Spinnerl.java
TableLayoutl.java

TableLayoutl0.java

TableLayoutll.java

TableLayout12.java

TableLayout2.java
TableLayout3.java

TableLayout4.java

TableLayout5.java

TableLayout6.java

TableLayout7.java
TableLayout8.java

TableLayout9.java
Tabs1.java
Tabs2.java
Tabs3.java
TextSwitcherl.java
Visibility1.java
WebViewl.java

Graphics
Drawable

ShapeDrawable
Demonstrates creating Drawables in XML.

OpenGL|ES

CameraPreview
Demonstrates capturing the image stream from the camera, drawing to a surface
(extending SurfaceView) on a separate thread (extending Thread).
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GL SurfaceView
Demonstrates how to perform OpenGL rendering in to a SurfaceView.

Code:
GLSurfaceViewActivity.java

Layout:
hello_world.xml

PolyToPoly
Demonstrates calling the {@link
android.graphics.Matrix.html#setPolyToPoly(float[],int,float[],int,int)} method to
translate coordinates on a canvas to a new perspective (used to simulate
perspective).

DrawPoints
Demonstrates using the {@link  android.graphics.Paint} and {@link
android.graphics.Canvas} objects to draw random points on the screen, with different
colors and strokes.

PathEffects
Demonstrates the use of {@link android.graphics.Path} and various {@link
android.graphics.PathEffect} subclasses.

SurfaceView Owverlay

Shows how you can place overlays on top of a SurfaceView.

Code:
SurfaceViewOwerlay.java, GLSurfaceView.java

Layout:
surface view_overlay.xml

TouchPaint
Demonstrates the handling of touch screen events to implement a simple painting

app.

Subdirectories

kube/
spritetext/

Files

AlphaBitmap.java

AnimateDrawable.java

AnimateDrawables.java
Arcs.java
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BitmapDecode.java

BitmapMesh.java

BitmapPixels.java
CameraPreview.java
Clipping.java
ColorMatrixSample.java

ColorPickerDialog.java

Compass.java
CreateBitmap.java

Cube.java
CubeRenderer.java
DrawPoints.java

FingerPaint.java
GLSurfaceViewActivity.java

GradientDrawablel.java

GraphicsActivity.java
Layers.java
MeasureText.java
PathEffects.java
PathFillTypes.java

Patterns.java
PictureLayout.java
Pictures.java
PolyToPoly.java
ProxyDrawable.java

Regions.java
RoundRects.java
ScaleToFit.java
SensorTest.java
ShapeDrawablel.java

SurfaceViewOwverlay.java

Sweep.java
TextAlign.java

TouchPaint.java
TouchRotateActivity.java

TranslucentGLSurfaceViewActivity.java

TriangleActivity.java

TriangleRenderer.java
Typefaces.java
UnicodeChart.java
Vertices.java
Xfermodes.java
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